notice

The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.

©January 2014

trademarks

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
Preface

R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Directive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Luxembourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland, United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slovenia.

ErP Off Mode Power Consumption Statement:
The figures below note the power consumption of this computer in compliance with European Commission (EC) regulations on power consumption in off mode:

• Off Mode < 0.5W
CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has attained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies to products regulated by certain European health, safety and environmental protection legislation. The CE Mark is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE Marking. A notified body has determined that this device has properly demonstrated that the requirements of the directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product. Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
Preface

FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.

And

2. This device must accept any interference, including interference that may cause undesired operation of the device.
FCC Statement  
(Federal Communications Commission) 
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re orient or relocate the receiving antenna.  
- Increase the separation between the equipment and receiver.  
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.  
- Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.  
And  
2. This device must accept any interference, including interference that may cause undesired operation of the device.
Preface

FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator and your body.

⚠️ Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.

If your purchase option includes both Wireless LAN and 3G modules, then the appropriate antennas will be installed. Note that in order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in conjunction with any other antenna or transmitter.

**Important Notice - 3G & Bluetooth/Wireless LAN Modules**

In order to comply with FCC regulations you should NOT operate the 3G module and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and cause interference. When the 3G module is powered on, make sure that the Bluetooth/Wireless LAN modules are powered off.
IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit:

• Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz, DC Output 19.5V, 6.15A (120W) minimum.
Preface

Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don’t drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

   ![Image 1]
   Do not expose the computer to any shock or vibration.

   ![Image 2]
   Do not place it on an unstable surface.

   ![Image 3]
   Do not place anything heavy on the computer.

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

   ![Image 4]
   Do not expose it to excessive heat or direct sunlight.

   ![Image 5]
   Do not leave it in a place where foreign matter or moisture may affect the system.

   ![Image 6]
   Don’t use or store the computer in a humid environment.

   ![Image 7]
   Do not place the computer on any surface that will block the Vents/Fan Intakes.
3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

<table>
<thead>
<tr>
<th>Do not turn off the power until you properly shut down all programs.</th>
<th>Do not turn off any peripheral devices when the computer is on.</th>
<th>Do not disassemble the computer by yourself.</th>
<th>Perform routine maintenance on your computer.</th>
</tr>
</thead>
</table>

5. **Take care when using peripheral devices.**

| Use only approved brands of peripherals. | Unplug the power cord before attaching peripheral devices. |
Power Safety

The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).

**Do not plug in the power cord if you are wet.**

**Do not use the power cord if it is broken.**

**Do not place heavy objects on the power cord.**
Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

- Polymer batteries may experience a slight expansion or swelling, however this is part of the battery’s safety mecha-
nism and is not a cause for concern.
- Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
Preface

General Battery Precautions

- Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
- Do not remove any batteries from the computer while it is powered on.
- Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire.
- If you do not use the battery for an extended period, then remove the battery from the computer for storage.
- Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
- Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
- Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
- Keep the battery away from metal appliances.
- Affix tape to the battery contacts before disposing of the battery.
- Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

- When the power cord or AC/DC adapter is damaged or frayed.
- If the computer has been exposed to rain or other liquids.
- If the computer does not work normally when you follow the operating instructions.
- If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
- If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before restoring power to the system.
Also note the following when the cover is removed:
- Hazardous moving parts.
- Keep away from moving fan blades.
Travel Considerations

Packing

As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

**Hand-carry the notebook** - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

**Beware of Electromagnetic fields** - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). **Note:** Some airports also scan luggage with these devices.

**Fly safely** - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

**Get power where you can** - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies) charged.

**Keep it dry** - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

- Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
- Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
- Use a chair with a back and adjust it to support your lower back comfortably.
- Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
- Take periodic breaks if you are using the computer for long periods of time.

Remember to:
- Alter your posture frequently.
- Stretch and exercise your body several times a day.
- Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Lighting
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

- Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
- Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
- Position the display directly in front of you at a comfortable viewing distance.
- Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for an extended period of time) take the following precautions:

- Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
- Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
- Rotate desktop background images every few days.
- Turn the monitor off when the system is not in use.

LCD Electro-Plated Logos
Note that in computers featuring a raised LCD electro-plated logo, the logo is covered by a protective adhesive. Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during transport. If any such wear and tear develops contact your distributor/supplier.
## Contents

Notice .............................................................................................................................................................I
ErP Off Mode Power Consumption Statement: ................................................................. II
FCC Statement ..............................................................................................................................................IV
FCC Statement .............................................................................................................................................V
FCC RF Radiation Exposure Statement: .......................................................................................... VI
Instructions for Care and Operation ........................................................................................... VIII
Power Safety ................................................................................................................................................ X
Polymer Battery Precautions ................................................................................................................ XI
General Battery Precautions .................................................................................................................. XII
Cleaning ................................................................................................................................................... XIII
Servicing .................................................................................................................................................. XIII
Travel Considerations ............................................................................................................................ XIV

### Quick Start Guide

Overview .................................................................................................................................................... 1-1
Advanced Users ........................................................................................................................................ 1-2
Beginners and Not-So-Advanced Users ........................................................................................... 1-2
Warning Boxes ................................................................................................................................. 1-2
Not Included .......................................................................................................................................... 1-3
System Software ............................................................................................................................... 1-4
System Startup ................................................................................................................................. 1-5
# Preface

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Map: LCD Panel Open</td>
<td>1-6</td>
</tr>
<tr>
<td>LED Indicators</td>
<td>1-7</td>
</tr>
<tr>
<td>Keyboard</td>
<td>1-8</td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
<td>1-9</td>
</tr>
<tr>
<td>Function Keys &amp; Visual Indicators</td>
<td>1-10</td>
</tr>
<tr>
<td>Control Center</td>
<td>1-11</td>
</tr>
<tr>
<td>System Map: Front &amp; Left Views</td>
<td>1-12</td>
</tr>
<tr>
<td>System Map: Right &amp; Rear Views</td>
<td>1-13</td>
</tr>
<tr>
<td>System Map: Bottom View</td>
<td>1-14</td>
</tr>
<tr>
<td>Windows 8.1 Control Panel</td>
<td>1-15</td>
</tr>
<tr>
<td>Windows 8.1 Start Screen &amp; Desktop</td>
<td>1-20</td>
</tr>
<tr>
<td>Apps &amp; Tiles</td>
<td>1-21</td>
</tr>
<tr>
<td>Desktop Application</td>
<td>1-22</td>
</tr>
<tr>
<td>The Charms Bar</td>
<td>1-23</td>
</tr>
<tr>
<td>Windows 8.1 Taskbar</td>
<td>1-25</td>
</tr>
<tr>
<td>Video Features</td>
<td>1-26</td>
</tr>
<tr>
<td>Microsoft Hybrid Graphics</td>
<td>1-26</td>
</tr>
<tr>
<td>Power Options</td>
<td>1-30</td>
</tr>
<tr>
<td>Running Apps</td>
<td>1-31</td>
</tr>
</tbody>
</table>

# Storage Devices, Audio & Mouse

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>2-1</td>
</tr>
</tbody>
</table>
Preface

Battery Power ................................................................................................................. 3-14
Conserving Battery Power ............................................................................................... 3-15
Battery Life .................................................................................................................... 3-16
New Battery ................................................................................................................... 3-16
Recharging the Battery with the AC/DC Adapter ............................................................. 3-16
Proper handling of the Battery Pack ............................................................................. 3-17
Battery FAQ ................................................................................................................... 3-18

Drivers & Utilities

What to Install ................................................................................................................. 4-1
Module Driver Installation ............................................................................................ 4-1
Driver Installation ......................................................................................................... 4-2
Updating/Reinstalling Individual Drivers ..................................................................... 4-4
User Account Control .................................................................................................. 4-5
Windows Security Message ........................................................................................... 4-5
New Hardware Found ................................................................................................... 4-5
Driver Installation Procedure ....................................................................................... 4-6
Chipset ........................................................................................................................... 4-6
Video (VGA) ................................................................................................................... 4-6
NVIDIA Video (VGA) .................................................................................................... 4-6
LAN ............................................................................................................................... 4-6
Card Reader ................................................................................................................... 4-6
Preface

Removing the Battery ..................................................................................................................6-4
Inserting the Battery ..................................................................................................................6-5
Removing the Component Bay Cover .......................................................................................6-6
Replacing the Component Bay Cover .......................................................................................6-8
Upgrading the Hard Disk Drive(s) ............................................................................................6-9
Upgrading the System Memory (RAM) ......................................................................................6-12

Modules

Overview ......................................................................................................................................7-1
Setting Up SATA RAID or AHCI Mode .......................................................................................7-2
AHCI Mode ..................................................................................................................................7-2
RAID ............................................................................................................................................7-2
Intel® Rapid Storage Technology Application .............................................................................7-2
SATA RAID Setup Procedure (Windows 8.1) ..............................................................................7-4
IRST Driver Installation ..............................................................................................................7-10
Deleting a RAID (Windows 8.1) ...............................................................................................7-11
PC Camera Module ....................................................................................................................7-12
PC Camera Audio Setup .............................................................................................................7-13
Camera App ...............................................................................................................................7-14
Camera Options .........................................................................................................................7-15
Taking Pictures/Capturing Video ..............................................................................................7-16
Camera Roll ...............................................................................................................................7-17
Preface

Wireless LAN Module ........................................................................................................................................7-21
3rd Party 802.11b/g/n Driver Installation ........................................................................................................7-22
Intel® WLAN Driver Installation ......................................................................................................................7-22
WLAN Configuration in Windows ....................................................................................................................7-23
Bluetooth & WLAN Combo Module ................................................................................................................7-26
3rd Party Bluetooth (V4.0) Combo Driver Installation ................................................................................7-27
Intel Bluetooth Combo Driver Installation ......................................................................................................7-27
Bluetooth Configuration in Windows ...............................................................................................................7-28
Intel® Rapid Storage Technology .....................................................................................................................7-31
IRST Driver Installation ..................................................................................................................................7-31
Intel® Rapid Storage Technology for RAID Systems ......................................................................................7-32
RAID Volume Data Verification and Repair ...................................................................................................7-34
Replacing and Reverting Recovery and Master Volumes ..............................................................................7-34
Intel® Smart Response Technology ..................................................................................................................7-36
Enabling Intel Smart Response Technology ..................................................................................................7-37
Intel® Rapid Start Technology Driver ..............................................................................................................7-40
Intel® Rapid Start Technology Configuration ..................................................................................................7-41
Intel® Rapid Start Technology Driver Installation ..........................................................................................7-47
Sound Blaster Cinema EQ ................................................................................................................................7-48
Sound Blaster Cinema EQ Installation ..............................................................................................................7-48
Sound Blaster Cinema Application ...................................................................................................................7-49
Sound Blaster Cinema Controls .......................................................................................................................7-51
Preface

Trusted Platform Module ......................................................................................................................... 7-53
Enabling & Activating TPM .................................................................................................................... 7-54
Trusted Platform Module (TPM) Driver Installation ............................................................................. 7-56
Initializing TPM ....................................................................................................................................... 7-57
Infineon Security Platform Settings Tool ............................................................................................... 7-59
Wireless Display ...................................................................................................................................... 7-67
Wireless Display Configuration ................................................................................................ .............. 7-68
3G Module ............................................................................................................................................... 7-71
3G Configuration in Windows .................................................................................................................. 7-73
EM820W 3G Module PIN Code & Power-Saving .................................................................................. 7-76

Troubleshooting

Overview .................................................................................................................................................... 8-1
Basic Hints and Tips ................................................................................................................................ 8-2
Backup and General Maintenance ............................................................................................................. 8-3
Viruses ....................................................................................................................................................... 8-4
Upgrading and Adding New Hardware/Software ...................................................................................... 8-5
Problems and Possible Solutions ............................................................................................................... 8-7
EM820W 3G Module PIN Code & Power-Saving .................................................................................. 8-15
Resolving the “Insert a SIM” issue with the 3G Module (Windows 8.1) ..................................................... 8-17

Interface (Ports & Jacks)

Overview ................................................................................................................................................... A-1
Preface

Ports and Jacks .......................................................................................................................................... A-2

Control Center
Overview ................................................................................................................................................... B-1

Video Driver Controls
Video Driver Installation ......................................................................................................................... C-1
Video (VGA) ........................................................................................................................................... C-1
NVIDIA Video (VGA) ............................................................................................................................... C-1
Microsoft Hybrid Graphics .................................................................................................................... C-2
Intel® Dynamic Video Memory Technology .......................................................................................... C-4
Intel® HD Graphics Control Panel ......................................................................................................... C-5
Display Devices & Options ................................................................................................................... C-19
Attaching Other Displays .................................................................................................................... C-20
Attaching Other Displays - Devices (Charms Bar) ................................................................................ C-23
Configuring an External Display In Windows ........................................................................................ C-24
NVIDIA Control Panel .......................................................................................................................... C-26
Optimus™ Customization Options ....................................................................................................... C-28
Set PhysX® Configuration .................................................................................................................... C-32
HDMI Audio Configuration ................................................................................................................... C-33

Specifications
Processors ................................................................................................................................................. D-2
# Preface

Core Logic .......................................................................................................................... D-2
Memory ............................................................................................................................... D-2
Display ............................................................................................................................... D-2
Video Adapter Options ...................................................................................................... D-2
Storage ............................................................................................................................... D-3
Audio ................................................................................................................................. D-3
Keyboard & Pointing Device ............................................................................................ D-3
Interface ............................................................................................................................ D-3
Card Reader ....................................................................................................................... D-3
Slots ................................................................................................................................. D-3
Communication ............................................................................................................... D-3
BIOS ................................................................................................................................. D-4
Security ............................................................................................................................. D-4
Operating System ........................................................................................................... D-4
Features ............................................................................................................................ D-4
Indicators .......................................................................................................................... D-4
Power ................................................................................................................................. D-4
Power Management ......................................................................................................... D-4
Environmental Spec ........................................................................................................ D-4
Physical Dimensions & Weight ....................................................................................... D-4
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

- **Chapter 2** A guide to using some of the main features of the computer e.g. the storage devices (hard disk, optical device, card reader), TouchPad & Mouse & Audio Features.
- **Chapter 3** The computer’s power management options.
- **Chapter 4** The installation of the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems.
- **Chapter 5** An outline of the computer’s built-in software or BIOS (Basic Input Output System).
- **Chapter 6** Instructions for upgrading your computer.
- **Chapter 7** A quick guide to the computer’s PC Camera, Wireless LAN, Fingerprint, Bluetooth & WLAN Combo, Intel technology, Sound Blaster Audio and 3G modules (some of which may be optional depending on your purchase configuration).
- **Chapter 8** A troubleshooting guide.
- **Appendix A** Definitions of the interface, ports/jacks which allow your computer to communicate with external devices.
- **Appendix B** Information on the Control Center.
- **Appendix C** Information on the Video driver controls.
- **Appendix D** The computer’s specification.
Quick Start Guide

Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “Drivers & Utilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1 in the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then the information contained in this Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a  as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the  symbol. Also please note the safety and handling instructions as indicated in the Preface.
Not Included
Operating Systems (e.g. *Windows 8.1*) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.

Drivers
If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed in *Table 4 - 1, on page 4 - 3*. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already done that for you), refer to “Drivers & Utilities” on page 4 - 1 for installation instructions.

You will need to attach an optical device drive to the computer in order to access the drivers on the *Device Drivers & Utilities + User's Manual* disc. This contains the drivers and utilities necessary for the proper operation of the computer.

Ports and Jacks
See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
System Software

Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find the *Windows 8.1 (64-bit)* operating system is supported.

**Windows OS**

In order to run *Windows 8.1 (64-bit)* your computer requires a minimum 2GB of system memory (RAM).
System Startup

1. Remove all packing materials, and place the computer on a stable surface.
2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
3. Make sure the battery is inserted and locked in position.
4. Attach the AC/DC adapter to the DC-In jack on the right of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter (make sure you use the adapter when first setting up the computer, as to safeguard the computer during shipping the battery will be locked to not power the system until first connected to the AC/DC adapter).
5. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees); use the other hand to support the base of the computer (Note: Never lift the computer by the lid/LCD).
6. Press the power button on the top right of the computer for about 2 - 3 seconds to turn the computer “on” (note that the power LED on the front of the computer will turn from orange to green when the computer powers on).

Shutdown

Note that you should always shut your computer down by choosing the Shut Down command in Windows (see page 1 - 30). This will help prevent hard disk or system problems.
System Map: LCD Panel Open

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the WLAN/Bluetooth/3G modules are OFF if you are using the computer aboard aircraft.

Use the Airplane Mode hot key combination to toggle Airplane Mode On/Off, and check the LED indicator for the power status.
LED Indicators

The LED indicators on the top case and front of the computer display helpful information about the current status of the computer.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔼</td>
<td>Blue</td>
<td>Number Lock is Activated (press Fn + Num Lk)</td>
</tr>
<tr>
<td>🔼</td>
<td>Blue</td>
<td>Caps Lock is Activated (press Caps Lock)</td>
</tr>
<tr>
<td>🔼</td>
<td>Blue</td>
<td>Scroll Lock is Activated (press Fn + Scr Lk)</td>
</tr>
<tr>
<td>🌟</td>
<td>Orange</td>
<td>AC/DC Power is Plugged In</td>
</tr>
<tr>
<td>🌟</td>
<td>Green</td>
<td>The Computer is On</td>
</tr>
<tr>
<td>🌟</td>
<td>Blinking Green</td>
<td>The Computer is in Sleep Mode</td>
</tr>
<tr>
<td>🌟</td>
<td>Blinking Orange</td>
<td>The Powered USB Port is On (see “Powered USB 3.0 Port” on page 1 - 13)</td>
</tr>
<tr>
<td>🌟</td>
<td>Orange</td>
<td>The Battery is Charging</td>
</tr>
<tr>
<td>🌟</td>
<td>Green</td>
<td>The Battery is Fully Charged</td>
</tr>
<tr>
<td>🌟</td>
<td>Blinking Orange</td>
<td>The Battery Has Reached Critically Low Power Status</td>
</tr>
<tr>
<td>🌟</td>
<td>Green</td>
<td>Airplane Mode is ON (the WLAN/Bluetooth/3G Modules are OFF)</td>
</tr>
<tr>
<td>🌟</td>
<td>Green</td>
<td>Hard Disk Activity</td>
</tr>
</tbody>
</table>

*Table 1 - 1 - Top Case LED Indicators*

*Table 1 - 2 - Front Case LED Indicators*
Keyboard

The illuminated keyboard has an embedded numerical keypad for easy numeric data input, and function keys to change operational features instantly. The keyboard illumination level may be adjusted, or turned off/on, by using the \textbf{Fn + F12} keys.

\textbf{NumLk & ScrLk}

Hold down the \textbf{Fn Key} and either NumLk or ScrLk to enable number or scroll lock, and check the LED indicator for status.

\textbf{Special Characters}

Some software applications allow the number-keys to be used with \textbf{Alt} to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that \textbf{NumLk} is on.
## Keyboard Shortcuts

The following Windows Logo Key (Winkey) keyboard shortcuts are useful for navigation/operation in *Windows 8.1*.

<table>
<thead>
<tr>
<th>Windows Logo Key +</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap Winkey</td>
<td>Toggle between the <strong>Start</strong> screen and the foremost running app or the <strong>Windows Desktop</strong></td>
</tr>
<tr>
<td>C</td>
<td>Display Charms menu</td>
</tr>
<tr>
<td>D</td>
<td>Switch to the <strong>Windows Desktop</strong> and toggle show Desktop</td>
</tr>
<tr>
<td>E</td>
<td>Switch to the Windows desktop and launch <strong>Windows Explorer</strong> with <strong>Computer</strong> displayed</td>
</tr>
<tr>
<td>F</td>
<td>Display file <strong>Search</strong></td>
</tr>
<tr>
<td>I</td>
<td>Open the <strong>Settings</strong> charm</td>
</tr>
<tr>
<td>K</td>
<td>Open the <strong>Connect</strong> charm</td>
</tr>
<tr>
<td>L</td>
<td>Lock the computer and display the <strong>Lock screen</strong></td>
</tr>
<tr>
<td>P</td>
<td>Display the <strong>Second Screen</strong> menu (see <em>Figure 1 - 20 on page 1 - 26</em>)</td>
</tr>
<tr>
<td>R</td>
<td>Switch to the <strong>Windows Desktop</strong> and display the <strong>Run</strong> dialog box</td>
</tr>
<tr>
<td>Z</td>
<td>Access the <strong>Customize Bar</strong> (see <em>Figure 1 - 15 on page 1 - 21</em>)</td>
</tr>
</tbody>
</table>

*Table 1 - 3 - Keyboard Shortcuts*
# Function Keys & Visual Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. Visual indicators (see the table below) are available when the Hot Key driver is installed.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function/Visual Indicators</th>
<th>Keys</th>
<th>Function/Visual Indicators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + $\text{F1}$</td>
<td>Play/Pause (in Audio/Video Programs)</td>
<td>Fn + $\text{F5}$ $\text{F6}$</td>
<td>Volume Decrease/Increase</td>
</tr>
<tr>
<td>Fn + $\text{F2}$</td>
<td>$\text{Control Center}$ Toggle (see over)</td>
<td>Fn + $\text{F7}$</td>
<td>Display Toggle</td>
</tr>
<tr>
<td>Fn + $\text{F3}$</td>
<td>Fan Control Toggle - Toggle between Automatic Fan Control / Full Power</td>
<td>Fn + $\text{F8}$ $\text{F9}$</td>
<td>Brightness Decrease/Increase</td>
</tr>
<tr>
<td>Fn + $\text{F4}$</td>
<td>Touchpad Toggle</td>
<td>Fn + $\text{F10}$</td>
<td>PC Camera Power Toggle</td>
</tr>
<tr>
<td>Fn + $\text{F5}$</td>
<td>Turn LCD Backlight Off (Press a key to or use Touchpad to turn on)</td>
<td>Fn + $\text{F11}$</td>
<td>Airplane Mode Toggle</td>
</tr>
<tr>
<td>Fn + $\text{F6}$</td>
<td>Mute Toggle</td>
<td>Fn + $\text{F12}$</td>
<td>Toggle Keyboard Illumination/Adjust Brightness Level</td>
</tr>
</tbody>
</table>

Table 1 - 4 - Function Keys & Visual Indicators
Control Center

When in the **Windows Desktop application** (not in the **Start** screen) press the **Fn + Esc** key combination, or **double-click the icon** in the **notification area of the taskbar** to toggle the **Control Center** on/off. The **Control Center** gives quick access to frequently used controls and enables you to quickly turn the camera/touch pad on/off (see **Appendix B** for full details).

*Figure 1 - 4 - Control Center*

**Control Center Access**

To run the Control Center press the **Fn + Esc** key combination, or double-click the icon in the notification area of the taskbar.

Close the Control Center by clicking the close icon in the top right of the panel (move the cursor onto the top right corner of the panel to highlight it).
System Map: Front & Left Views

1. LED Indicators
2. Vent/Fan Intake
3. Multi-In-1 Card Reader
4. USB 2.0 Port
5. Headphone-Out Jack
6. Microphone-In Jack

**Sound Blaster Cinema Audio**

Note that you will need to install the Sound Blaster audio application in order to get maximum audio performance.

**Multi-In-1 Card Reader**

The card reader allows you to use the most popular digital storage card formats:
- MMC (MultiMedia Card) / RS MMC
- SD (Secure Digital) / Mini SD / SDHC / SDXC

The card reader features a push-in/push-out card insertion and ejection mechanism. Simply push the card to insert and eject it, however some cards may require an adapter.

**Optical Device Drives**

To install applications and drivers etc. you will need to attach an external optical CD/DVD device to the USB ports.
System Map: Right & Rear Views

1. 1 * Powered (AC/DC) USB 3.0 Port
2. 2 * USB 3.0 Ports
3. HDMI-Out Port
4. External Monitor Port
5. RJ-45 LAN Jack
6. DC-In Jack
7. Security Lock Slot
8. Battery

USB 3.0 Port OR USB 2.0 Port

This model includes 1 * USB 2.0 port and 3 * USB 3.0 ports (including one AC/DC powered USB 3.0 port). USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black.

Powered USB 3.0 Port

The powered USB 3.0 port can supply power (for charging devices only, not for operating devices) when the system is off but still powered by the AC/DC adapter plugged into a working outlet, or powered by the battery with a capacity level above 20% (this may not work with certain devices - see page 8 - 11). Toggle power to this port by using Fn + power button.

HDMI Port

Note that the HDMI Port supports video and audio signals to attached external displays. Note that Sound Blaster audio will be disabled when you are connecting to an external display through an HDMI connection (see page 7 - 52).
Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 14 for full instructions.

CPU

The CPU is not a user serviceable part.

Overheating

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake while the computer is in use.
Windows 8.1 Control Panel

Throughout this manual you will see an instruction to open the Control Panel. Right-click the lower left hot corner to bring up the context menu (or use the Windows Logo Key + X key combination) and select Control Panel in both the Desktop app or Start screen.

Figure 1 - 8 - Windows Context Menu

Windows Versions

Note that the information included on the following pages is for Windows 8.1 only.

The Windows 8 interface is slightly different in appearance and in methods of navigation, and a separate manual is provided on the Device Drivers & Manual Disc with reference to Windows 8.
Right-click the Start button in the Desktop app (or use the Windows Logo Key + X key combination) to bring up an advanced context menu of useful features such as Control Panel, Programs and Features, Power Options, Task Manager, Search, File Explorer, Command Prompt, Device Manager and Network Connections etc.

Display Most Recently Used Apps

If you are in the Start screen, Desktop or an app you can move your mouse to the upper left corner of the screen to get back to the most recently used app.

To view all the most recently used Apps hover over the top left of the screen and then move the mouse down along the left side of the screen to display the list.

Move the mouse to the bottom left of the screen and right-click the Start button to access the menu.

Figure 1 - 9 - Advanced Context Menu (Right-Click Start Button)
The Control Panel can be accessed in a number of ways in *Windows 8.1*.

- Click **Search** in the **Windows Charms Bar** (see previous page) and the search pane will pop out. Type *Control Panel* and select it from the results to the left.

  *Figure 1 - 10 - Search (Control Panel)*

- Click on **This PC** (in Apps, or you can pin **This PC** to the **Start** screen), click on **Computer** in the top menu and select **Open Control Panel** from the ribbon.

  *Figure 1 - 11 - Open Control Panel (Computer)*
Quick Start Guide

- When in the Desktop app (this does not apply to the Start screen) click on Settings in the Windows Charms Bar and select Control Panel from the menu.

![Settings Charms Bar (Desktop App Only)](image)

*Figure 1 - 12 - Settings Charms Bar (Desktop App Only)*

- Click the arrow at the bottom of the Start screen and click Control Panel in Apps (Windows System).

![All Apps - Control Panel](image)

*Figure 1 - 13 - All Apps - Control Panel*
• Right-click the **Start** button bring up the menu and select Control Panel (see *Figure 1 - 9 on page 1 - 16*).

---

**Keyboard Shortcut to Control Panel**

You can also use keyboard shortcuts to access the Control Panel. Press the **Windows logo key** and **X** to bring up the context menu, and then press **P** to bring up the Control Panel. Alternatively press the **Windows logo key** and **R** to bring up the **Run** dialog box, and then type "**Control Panel**" and press Enter to access the Control Panel.
Windows 8.1 Start Screen & Desktop

The Apps, control panels, utilities and programs within Windows are accessed from the Start screen and/or Windows Desktop app. The Desktop (which runs as an app within the Start screen) can be accessed by clicking the Desktop item in the Start screen (or by using the Windows Logo Key + D key combination). Click the arrow at the bottom of the Start screen to access Apps.

![Figure 1 - 14 - Windows Start Screen](image)

1 - 20 Windows 8.1 Start Screen & Desktop
Apps & Tiles

The Start screen will contain a number of apps, and many more will be installed as you add more applications etc. Not all of these apps can fit on one screen so you will often need use the slider at the bottom of the screen in order to view all the necessary Apps.

Accessing Pining/Unpinning All Apps

You can add and remove the tiles for apps and control panels in the Start screen. Right-click on a blank area of the Start screen, and you will see the Customize icon. Click the Customize icon to display all the installed applications etc. Right-click any icon to bring up the menu at the bottom of the screen and you can then click the appropriate icon to pin the App to (or unpin from) the Start screen, or to the taskbar in the Desktop application (you can also open the app in a new window, run as administrator or open the file location).

Figure 1 - 15 - Customize Apps
Desktop Application

When the Desktop app is running (click the app in the Start screen or use the Windows Logo Key + D key combination) you can use lower left hot corner to switch between the Start screen and the Windows Desktop app. To do so move your mouse to hover over the bottom left corner of the Desktop app and left-click.

When you move to the lower left hot corner in the Start screen it will take you back to your most recently used app (if one is running).

Figure 1 - 16 - Desktop

Move the mouse to the bottom left of the screen and click to switch back to the Start screen.
The Charms Bar
The right side of the screen displays the Charms Bar. The Charms Bar contains the Search, Share, Start, Devices and Settings menus. To access up the Charms Bar move the cursor to the upper or lower right corners of the screen, and then hover over one of the items in the Charms Bar to activate it (the bar will be black when it is active), or use the Windows Logo Key + C key combination.

Figure 1 - 17 - Start Screen with Charms Bar
Quick Start Guide

Charms Bar Items

- **Search**: You can search for any file, application, Apps and control panel settings with instantaneous results.

- **Share**: This button is used to share information with people via mail or social networks.

- **Start**: Click to bring up the **Start** screen (the same function as pressing the Windows Logo Key or clicking the bottom left of the screen).

- **Devices**: Click this button to change connected peripheral device settings e.g. an external display.

- **Settings**: This button gives instant access to the computer settings, such as Network, Audio, Notifications, Power and Keyboard (click **Change PC Settings** to activate the PC Settings menu).

Charms Bar - TouchPad Access

To quick access the **Charms Bar** using the TouchPad:

1. Place your finger **off** the TouchPad (slightly to the right of the pad resting on the computer).
2. Move your finger across to the left on to the TouchPad.
3. The Charms Bar will then pop-up.

*Figure 1 - 18 - Settings Menu*
Windows 8.1 Taskbar

In many instances throughout this manual you will see an instruction to access the **notification area of the taskbar (system tray)**. In *Windows 8.1* the taskbar is accessed from the **Desktop** application; if you are in the **Start** screen you will need to switch to the **Desktop**.

The taskbar is displayed at the bottom of the **Desktop** screen, and you can see the **notification area (system tray)** of the taskbar in the bottom right of the screen. Some of the control panels and applications referred to during the course of this manual can be accessed from here.

![Desktop Taskbar & Notification Area (System Tray)](image)

*Figure 1 - 19 - Desktop Taskbar & Notification Area (System Tray)*

You can pin/unpin apps to/from the taskbar in much the same way as you can to the **Start** screen (see “**Accessing Pining/Unpinning All Apps**” on page 1 - 21).
Quick Start Guide

Video Features

Microsoft Hybrid Graphics

Microsoft Hybrid Graphics is a seamless technology designed to get best performance from the graphics system while allowing longer battery life, without having to manually change settings. The computer will automatically switch between the integrated UMA (Unified Memory Architecture) GPU (iGPU) and the discrete GPU (dGPU) when required by the applications in use.

You can switch display devices, and configure display options, from the Display control panel (in Appearances and Personalization) when running the Desktop app (see “Desktop Application” on page 1 - 22 and Appendix C). It is possible to quickly configure external displays from the Devices menu item in the Charms Bar (see “The Charms Bar” on page 1 - 23).

To Configure Displays from Devices (Charms Bar):

1. Attach your display to the appropriate port, and turn it on.
2. Go the Charms Bar, select Devices.
3. Click Project (you may need to click Second Screen).
4. Click on any one of the options from the menu to select PC screen only, Duplicate, Extend or Second screen only.

Figure 1 - 20 - Devices (Project)
To access Display (Control Panel) and Screen Resolution in Windows:
1. Go to the Control Panel.
2. Click Display (icon) - In the Appearance and Personalization category.
3. Adjust resolution.

Right-Click Desktop App
1. You can right-click the desktop and select Screen resolution (Figure 1 - 21).
2. Use the dropbox to select the screen Resolution (Figure 1 - 21).
3. Click Advanced settings (Figure 1 - 21) to bring up the Advanced properties tabs.

Figure 1 - 21 - Screen Resolution
Quick Start Guide

To access the *Intel(R) HD Graphics Control Panel*:
1. Click **Advanced settings** (Figure 1 - 21 on page 1 - 27) in the **Screen Resolution** control panel in **Windows**.
2. Click the **Intel(R)...** tab and click **Graphics Properties** (button) (Figure 1 - 22 on page 1 - 28).
3. Right-click the desktop and select **Graphics Properties** from the menu.
4. Click the icon in the notification area of the Desktop taskbar and select **Graphics Properties** from the menu.

*Figure 1 - 22 - Intel Graphics Control Panel*
To access the **NVIDIA Control Panel**: 
1. Right-click the desktop and select **NVIDIA Control Panel** *(Figure 1 - 23).* 
OR 
2. Double-click the icon *(Figure 1 - 23)* in the **Windows** control panel.
Quick Start Guide

Power Options

Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power Menu item in Settings in the Charms Bar in Windows 8.1 may be used to Shut down or Restart (you can also add Hibernate/Sleep to the menu - see “Adding Hibernate/Sleep to the Power Menu” on page 3 - 10). You can also use the context menu (Shut down or sign out) shut the computer down/restart etc.

Shut Down, Restart or Sleep (Charms Bar)
1. Go to the Charms Bar and click Settings.
2. Click Power.
3. Select Sleep, Shut Down or Restart.

Figure 1 - 24 - Shut Down/Restart

1 - 30 Power Options
Running Apps

To run apps in *Windows 8.1* you will need to check that the **Screen Resolution** and **User Account Control Settings** are compatible with the system requirements.

**Screen Resolution Settings**

1. Switch to the Windows Desktop (click the app or use the Windows logo key + D key combination).
2. Right-click a blank area of the Windows Desktop and select **Screen Resolution**. Adjust the **Resolution** to make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above (see sidebar).

![Screen Resolution](image)

**Screen Resolution for Apps (Windows 8.1)**

The minimum resolution in which Apps will run is **1024x768**.

The minimum resolution required to support all the features of Windows 8 (including multitasking with snap) is **1366x768**.

These specs are the minimum screen resolution that supports all the features of Windows 8.1 on a useful physical size.

*Figure 1 - 25 - Screen Resolution*
Quick Start Guide

User Account Control Settings
If your computer meets the minimum screen resolution requirements, and still you can't run apps, then that you have to check the status of User Account Control (UAC). Apps may fail to open when the UAC is turned off. To check whether the UAC is on or off, follow the instructions below.

1. Open the Control Panel.
2. Click on User Accounts and then click on Change User Account Control settings (or click System and Security and click Change User Account Control Settings under Action Center).
3. If the slider is in the Never notify position, then the UAC is disabled.
4. To enable or turn on the UAC, move the slider to Always notify or Notify me when apps try to make changes to my computer (default) position, and then click OK.

Figure 1 - 26 - User Account Control
Chapter 2: Storage Devices, Audio & Mouse

Overview

Read this chapter to learn more about the following main features and components of the computer:

- Hard Disk Drive
- Multi-in-1 Card Reader
- Audio Features
- Touchpad and Buttons/Mouse
Hard Disk Drive

The hard disk drive(s) is(are) used to store your data in the computer. The hard disk(s) can be taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height of 9.5 mm or 7mm. The hard disk is(are) accessible after removing the component bay cover from the bottom of your computer as seen below.

Further details on removing and inserting the hard disk are available in “Upgrading the Hard Disk Drive(s)” on page 6 - 9.

Figure 2 - 1
Hard Disk Location

Warranty Warning
Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.
Multi-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device, and can be accessed in the same way as your hard disk(s). Make sure you install the Card Reader driver (see “Card Reader” on page 4 - 6).

- MMC (MultiMedia Card) / RSMMC
- SD (Secure Digital) / Mini SD / SDHC / SDXC

Note: Some of these cards require PC adapters that are usually supplied with the cards.
Audio Features

You can configure the audio options on your computer from the Sound control panel in Windows, from the HD VDeck icon on the desktop or VIA HD Audio Deck control panel.

The volume may also be adjusted by means of the Fn + F5/F6 key combination.

Sound Volume Adjustment

The sound volume level is set using the volume control on the Windows desktop (and the volume function keys F5/F6 on the computer). Click the volume icon in the taskbar to check the setting.

Figure 2 - 3
VIA HD Audio Deck
Expert Mode will allow you to access more advanced configuration menus for Speaker and Microphone.

Note that to adjust the Left & Right volume balance independently click the Sync Left and Right Volume icon (it should be faded) and adjust the slider as required.

Sound Blaster Cinema Audio

Note that you will need to install the Sound Blaster Cinema audio application in order to get maximum audio performance. See “Sound Blaster Cinema EQ” on page 7 - 48.
The Touchpad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The Touchpad buttons function in much the same way as a two-button mouse.

Once you have installed the Touchpad driver (see “TouchPad” on page 4 - 6) you can configure the functions by double-clicking the Touchpad driver icon in the notification area of the taskbar. You may then configure the Touchpad tapping, buttons, scrolling (see sidebar), pointer motion and sensitivity options to your preferences.

**Touchpad Scrolling**

This computer model series may feature different Touchpad versions.

These Touchpads may differ in their vertical scrolling function in most scrollable windows.

Some Touchpads require sliding the finger up and down on the right of the Touchpad to scroll the window. Other versions require tapping/holding down the finger at the top right or bottom right of the Touchpad to scroll the window.

**Figure 2 - 5**

Mouse Properties
The Synaptics Gestures Suite application allows you to use a specific gesture (action) on the surface of the Touchpad to perform specific actions to manipulate documents, objects and applications.

You can configure the settings from the Device Settings tab in **Mouse Properties**:
1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Click **Mouse** (**Hardware and Sound**).
3. Click **Device Settings** (tab) and click **Settings**.
4. Use the menu tree on the left to access the user configurable settings.

You can get a clearer view of the gestures involved by clicking the **Show Video** option for each gesture item.

Select the gesture (**Pinch Zoom**, **Rotating**, **Three Fingers Down** and **Three Finger Flick**) in the **Device Settings > Settings** left tree menu and click the **Show Video** button to see the demonstration video.

For more details on any of the gestures see the help in the lower part of the right menu window.

**Figure 2 - 6**
**Mouse Properties - Device Settings**
Disabling the Touchpad
If you need to disable the Touchpad for any reason (e.g. you may find that when using the computer’s internal keyboard you accidentally trigger the Touchpad when resting your wrists or palms on it) you can do so by using **Fn + F1** key combination.

You can also set the system to automatically disable the internal Touchpad when an external USB point device (e.g. a USB mouse) is attached.

1. Go to the **Mouse Properties** control panel.
2. Click to select **Device Settings** (tab).
3. Click to place a tick in the “**Disable internal pointing device when external USB pointing device is attached**” tickbox.
4. Click **OK** to save the setting.
Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you to scroll horizontally and vertically. Place two fingers, slightly separated, on the Touchpad surface and slide both fingers in the direction required (in a straight continuous motion).

Zooming
The Pinch Zoom gesture can be used to perform the same function as a scroll wheel in Windows applications that support CTRL + scroll wheel zoom functionality. Place two fingers on the Touchpad (for best results use the tips of the fingers) and slide them apart to zoom in, or closer together to zoom out.
Storage Devices, Audio & Mouse

Rotating
Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments. Place a finger down on the left “target” zone and keep it stationary. Place another finger near the middle of the Touchpad and slide it in a circular motion around the stationary finger (clockwise or counterclockwise) to rotate the object.

Three Finger-Flick/Three Fingers Down (Press)
The Three Finger-Flick gesture may be used to enhance navigation with a variety of applications such as browsing the Internet or scrolling through a photo viewer. The Three Fingers Down gesture may be used to launch user-selectable applications.
Chapter 3: Power Management

Overview

To conserve power, especially when using the battery, your computer power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system. This chapter covers:

- The Power Sources
- Turning On the Computer
- Power Plans
- Power-Saving States
- Configuring the Power Buttons
- Battery Information

The computer uses enhanced power saving techniques to give the operating system (OS) direct control over the power and thermal states of devices and processors. For example, this enables the OS to set devices into low-power states based on user settings and information from applications.

OS Note

Power management functions will vary slightly depending on your operating system. For more information it is best to refer to the user’s manual of your operating system.
The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components.

1. Make sure the battery is inserted and locked in position.
2. Attach the AC/DC adapter to the DC-In jack on the right of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter (make sure you use the adapter when first setting up the computer, as to safeguard the computer during shipping the battery will be locked to not power the system until first connected to the AC/DC adapter).
3. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees); use the other hand to support the base of the computer.
4. Press the power button on the top right of the computer for about 2 - 3 seconds to turn the computer “on”.

Battery
The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “Battery FAQ” on page 3 - 18).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 14.
Turning On the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options (Hardware and Sound) in the Windows control panel to configure this feature.

Power Button as Stand by or Hibernate Button

You can use the OS's "Power Options" control panel to set the power button to send the system into Stand by or Hibernate mode (see your OS's documentation, or "Configuring the Power Buttons" on page 3 - 9 for details).
Shutting the Computer Down

Note that you should always shut your computer down by choosing the **Shut down** command as this will help prevent hard disk or system problems. Use the **Shut down or sign out** item in the **Context Menu** (right-click the lower left corner of the screen to bring up the menu).

You can also use the **Power Menu** in **Settings** in the **Windows 8.1 Charms Bar**. If you want to add Hibernate/Sleep to the Power Menu see “**Adding Hibernate/Sleep to the Power Menu**” on page 3 - 10.
Power Plans

The computer can be configured to conserve power by means of **power plans**. You can use (or modify) an existing **power plan**, or create a new one.

The settings may be adjusted to set the **display** to turn off after a specified time, and to send the computer into **Sleep** after a period of inactivity.

Click **Change plan settings** and then click **Change advanced power settings** to access further configuration options in **Advanced Settings**.

---

**Resuming Operation**

See *Table 3 - 1, on page 3 - 11* for information on how to resume from a power-saving state.

**Password**

It is recommended that you enable a password on system resume in order to protect your data.

**Figure 3 - 2**

Power Plan Advanced Settings
Each *Windows power plan* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose *High performance* (you may need to click *Show additional plans* to view the High performance plan) for maximum performance when the computer is powered from an AC power source. Choose the *Power saver* (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.
Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where you left off. *Win 8.1* uses the *Sleep*, *Hibernate* and *Shut Down* power-saving states.

**Sleep**

In *Sleep* all of your work, settings and preferences are saved to memory before the system sleeps. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter *Sleep* to save power.

The PC wakes from *Sleep within seconds* and will return you to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

If your mobile PC in *Sleep* is running on battery power the system will use only a minimum amount of power. After an extended period the system will save all the information to the hard disk and shut the computer down before the battery becomes depleted.

To add *Sleep* to the *Power Menu* see “*Adding Hibernate/Sleep to the Power Menu*” on page 3 - 10.
Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves all of your information on a part of the hard disk before it turns the system off. If a power failure occurs the system can restore your work from the hard disk; if a power failure occurs when work is saved only to memory, then the work will be lost. Hibernate will also return you to where you last left off within seconds. You should put your mobile PC into Hibernate if you will not use the computer for a period of time, and will not have the chance to charge the battery. To add Hibernate to the Power Menu see “Adding Hibernate/Sleep to the Power Menu” on page 3 - 10.

Shut down

You should Shut down the computer if you plan to install new hardware (don’t forget to remove the battery and follow all the safety instructions in Chapter 6), plan to be away from the computer for several days, or you do not need it to wake up and run a scheduled task. Returning to full operation from Shut down takes longer than from Sleep or Hibernate.
Configuring the Power Buttons

The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the computer in to a power-saving state. Click **Choose what the power buttons do** on the left menu in **Power Options** to bring up the menu.

*Password Protection*

It is recommended that you enable a password on wake up in order to protect your data.

However you can disable this setting from the **Power Options** menu by clicking **Require a password on wakeup** in the left menu, and selecting the options (click **Change settings that are currently unavailable**).

---

*Figure 3 - 5*

**Power Options Define Power Buttons**
Power Management

Adding Hibernate/Sleep to the Power Menu
Add Hibernate/Sleep to the Power Menu as follows.

1. Go to the Power Options (Hardware and Sound) control panel.
2. Click “Change settings that are currently unavailable”.
3. Click Choose what the power buttons do.
4. Click to put a tick in the Hibernate/Sleep box under Shutdown settings.
5. Click Save Changes and close the control panel.

Figure 3 - 6
Power Options
Define Power Buttons - Shutdown Settings
Resuming Operation

You can resume operation from power-saving states by pressing the power button, or in some cases pressing the sleep button ($\text{Fn} + \text{F4}$ key combo).

<table>
<thead>
<tr>
<th>Power Status</th>
<th>Icon</th>
<th>Color</th>
<th>To Resume</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Off</td>
<td>Off</td>
<td></td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Sleep</td>
<td>Blinking Green</td>
<td></td>
<td>Press the Power Button</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Press the Sleep Button ($\text{Fn} + \text{F4}$ Key Combo)</td>
</tr>
<tr>
<td>Hibernate</td>
<td>Off (battery)</td>
<td></td>
<td>Press the Power Button</td>
</tr>
<tr>
<td></td>
<td>Orange (AC/DC adapter)</td>
<td></td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Display Turned Off</td>
<td>Green</td>
<td></td>
<td>Press a Key or Move the Mouse/Touchpad</td>
</tr>
</tbody>
</table>

*Table 3 - 1 Resuming Operation*

---

**Power Button**

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down hot key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will force the computer to shut down).

---

**Closing the Lid**

If you have chosen to send the computer to Sleep when the lid is closed, raising the lid will wake the system up.
Power Management

Power Conservation Modes

This system supports Energy Star power management features that place computers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period of inactivity. Adjust Power Conservation Modes from the Control Center:

1. Press the Fn + Esc key combination to toggle the Control Center on/off.
2. Click either the Performance, Balanced or Energy Star button.

The Energy Star setting will result in maximum power saving, but with the possible loss of some performance.

Setting the mode to Balance will give power saving matched with performance.

Performance will give optimum computer performance but with less power conservation.

Note that the Energy Star setting will put the display into sleep after no more than 15 minutes of user inactivity.

Figure 3 - 7
Control Center

3 - 12 Configuring the Power Buttons
Ctrl + Alt + Delete Key Combination
You can use the CTRL + ALT + DEL key combination from almost any of the Windows 8 interfaces/Apps to bring up a full-screen displaying Lock, Switch User, Log off, Change a password and Task Manager options. If you click the Power icon in the lower right corner of the screen a power management option menu appears to display Sleep, Shut down, and Restart.

To fully control all the power options (including Hibernate mode) go to the Power Options control panel and configure the power button, sleep button and lid to perform the function selected.
Battery Information

Follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the programs you are running, and peripheral devices attached. You can set actions to be taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from power plan Change plan settings > Change advanced power settings (see Figure 3 - 3 on page 3 - 6).

Click the battery icon in the notification area to see the current battery level and charge status.
Conserving Battery Power

- Use a power plan that conserves power (e.g. Power saver), however note that this may have an affect on computer performance.
- Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.
- Reduce the amount of time before the display is turned off.
- Close wireless, Bluetooth, modem or communication applications when they are not being used (e.g. put the system in Airplane Mode).
- Disconnect/remove any unnecessary external devices e.g. USB devices, ExpressCards etc.

The Windows Mobility Center control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.
Battery Life
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason (e.g. long term storage) see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page 3 - 18 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. Refer to “LED Indicators” on page 1 - 8 for information on the battery charge status, and to “Battery Information” on page 3 - 14 for more information on how to maintain and properly recharge the battery pack.
Proper handling of the Battery Pack

- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

**Caution**

Danger of explosion if battery is incorrectly replaced.
Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.

**Damaged Battery Warning**

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your distributor/supplier. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click *Change plan settings* (after creating it) and click *Change plan settings > Change advanced power settings*.
4. Scroll down to **Battery** and click + to expand the battery options.

5. Choose the options below (click **Yes** if a warning appears):

- Low battery levels = 0%
- Critical battery Levels = 1%
- Low battery action = Do Nothing
- Critical battery action (On battery) = Shut Down
- Critical battery action (Plugged in) = Do Nothing

---

**Figure 3 - 13**

*Power Options*

*Advanced Settings - Battery*
How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities.

What to Install

You will need to attach an external DVD drive to install the drivers from the Device Drivers & Utilities + User’s Manual disc. Table 4 - 1, on page 4 - 3 lists what you need to install and it is very important that the drivers are installed in the order indicated.

Note that the information included on the following pages is for Windows 8.1 only.

Module Driver Installation

The procedures for installing drivers for the PC Camera, WLAN and Combination Bluetooth & WLAN modules (you should also install the Sound Blaster Cinema, Intel Technology drivers) are provided in “Modules” in Chapter 7.
Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached optical (DVD) drive.
2. Click the message “Tap to choose what happens with this disc.”
3. Click Run autorun.exe.
4. Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.
5. Check the driver installation order from Table 4 - 1, on page 4 - 3 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.
6. Click to select the driver you wish to install, (you should note down the drivers as you install them).
7. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Figure 4 - 1 - Drivers Installer Screen 1

Figure 4 - 2 - Install Drivers

4 - 2 Driver Installation
### Table 4 - 1 - Driver Installation

All drivers provided are for the Windows 8.1 operating system.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.

<table>
<thead>
<tr>
<th>Win 8.1 Driver</th>
<th>Page #</th>
<th>Win 8.1 - Optional Items</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset</td>
<td>Page 4 - 6</td>
<td>Setting Up SATA RAID or AHCI Mode</td>
<td>Page 7 - 2</td>
</tr>
<tr>
<td>Video (VGA)</td>
<td>Page 4 - 6</td>
<td>PC Camera Module (No driver required)</td>
<td>Page 7 - 12</td>
</tr>
<tr>
<td>NVIDIA Video (VGA)</td>
<td>Page 4 - 6</td>
<td>Wireless LAN Module</td>
<td>Page 7 - 21</td>
</tr>
<tr>
<td>LAN</td>
<td>Page 4 - 6</td>
<td>Bluetooth &amp; WLAN Combo Module</td>
<td>Page 7 - 24</td>
</tr>
<tr>
<td>Card Reader</td>
<td>Page 4 - 6</td>
<td>Intel® Rapid Storage Technology (required for hard disks in AHCI mode)</td>
<td>Page 7 - 31</td>
</tr>
<tr>
<td>TouchPad</td>
<td>Page 4 - 6</td>
<td>Intel® Rapid Start Technology Driver</td>
<td>Page 7 - 40</td>
</tr>
<tr>
<td>Hot Key</td>
<td>Page 4 - 7</td>
<td>Sound Blaster Cinema EQ</td>
<td>Page 7 - 48</td>
</tr>
<tr>
<td>Airplane</td>
<td>Page 4 - 7</td>
<td>Trusted Platform Module</td>
<td>Page 7 - 53</td>
</tr>
<tr>
<td>MEI Driver</td>
<td>Page 4 - 7</td>
<td>Wireless Display (No driver required)</td>
<td>Page 7 - 67</td>
</tr>
<tr>
<td>Audio</td>
<td>Page 4 - 7</td>
<td>3G Module (No driver required)</td>
<td>Page 7 - 71</td>
</tr>
</tbody>
</table>
Drivers & Utilities

Manual Driver Installation
Click **Browse CD/DVD** (button) in the *Drivers Installer* application and browse to the executable file in the appropriate driver folder.

Windows Update
After installing all the drivers make sure you enable **Windows Update** in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft). See “**Windows Update**” on page 4 - 8 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the **Control Panel** in the *Windows OS* and double-click the **Programs and Features** icon (**Programs > Uninstall a program**). Click to select the driver (if it is not listed see below) and click **Uninstall**, and then follow the on screen prompts (it may be necessary to restart the computer). Reinstall the driver as outlined in this chapter.

If the driver is not listed in the **Programs and Features** menu:

1. Go to the **Control Panel**.
2. Double-click **Device Manager** (**Hardware and Sound > Devices and Printers > Device Manager**).
3. Double-click the **device** you wish to update/reinstall the driver for (you may need to click “+” to expand the selection).
4. Click **Driver** (tab) and click the **Update Driver** or **Uninstall** button and follow the on screen prompts.

---

4 - 4 Driver Installation
User Account Control
If a User Account Control prompt appears as part of the driver installation procedure, click Continue or Allow, and follow the installation procedure as directed.

Windows Security Message
If you receive a Windows security message as part of the driver installation process. Just click “Install this driver software anyway” or “Install” to continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure.

Driver Installation General Guidelines
The driver installation procedure outlined in this Chapter (and in Chapter 7 Options & Modules), are accurate at the time of going to press.

Drivers are always subject to upgrade and revision so the exact procedure for certain drivers may differ slightly. As a general guide follow the default on screen instructions for each driver (e.g. Next > Next > Finish) unless you are an advanced user. In many cases a restart is required to install the driver.

Make sure any modules (e.g. WLAN or Bluetooth) are ON (i.e. the system is not in Airplane Mode) before installing the appropriate driver.
Drivers & Utilities

Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual disc into your attached CD/DVD drive and click Install Drivers (button).

Chipset
1. Click Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video (VGA)
1. Click Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

NVIDIA Video (VGA)
1. Click Install NVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to accept the terms of the license agreement.
3. Click Next.
4. Click Close to complete the installation.

Note: After installing the video driver go to the Display/Display Settings control panel to adjust the video settings to the highest resolution.

LAN
1. Click Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.

Card Reader
1. Click Install Cardreader Driver > Yes.
2. Click Finish.

TouchPad
1. Click Install Touchpad Driver > Yes.
2. Click Next.
3. Click the button to accept the license, and then click Next.
4. Click Finish > Restart Now to restart the computer.
Hot Key
1. Click **7.Install Hotkey AP > Yes.**
2. Click **Next.**
3. Click **Finish** to restart your computer.

Airplane
*Note: Do not use Update Driver in Device Manager to install the Airplane Mode driver.*
1. Click **8.Install Airplane AP > Yes.**
2. Click **Next.**
3. Click **Finish** to restart the computer.

MEI Driver
1. Click **9.Install MEI Driver > Yes.**
2. Click **Next > Yes > Next.**
3. Click **Finish.**

Audio
1. Click **10.Install Audio Driver > Yes.**
2. Click **Next.**
3. **Click Install.**
4. **Click Finish.**
5. **Click Finish** to restart the computer.

After installing the audio driver the system will not return to the **Drivers Installer** screen. To install any of the optional drivers, eject the Device Drivers & Utilities + User’s Manual disc and then reinsert it (or double-click the disc icon in My Computer), and click **Option Drivers** (button) to access the optional driver menu.

It is recommended that you install the **Sound Blaster Audio** application for maximum audio performance (see “**Sound Blaster Cinema EQ**” on page 7-48) and **Intel Rapid Storage Technology** driver (see “**Intel® Rapid Storage Technology**” on page 7-31 - required for AHCI or RAID mode).
Drivers & Utilities

Optional Drivers

See the pages indicated in Table 4 - 1, on page 4 - 3 for the driver installation procedures for any modules included in your purchase option.

![Optional Drivers Installer Screen](image)

**Figure 4 - 3 - Optional Drivers Installer Screen**

Note that you need to install both the WLAN & Bluetooth drivers for all the Bluetooth Combo modules.

---

**Windows Update**

After installing all the drivers make sure you enable Windows Update in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft).

To enable Windows Update make sure you are connected to the internet:

1. Go to the Control Panel.
2. Click Windows Update (System and Security/Security).
3. Click Check for updates (button).
4. The computer will now check for updates (you need to be connected to the internet).
5. Click Install now (button) to begin checking for the updates.
6. Click Install updates (button) to install the updates.
Chapter 5: BIOS Utilities

Overview

This chapter gives a brief introduction to the computer’s built-in software:

If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in Setup. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you are doing. Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.
The Setup Utility

Each time you turn on the computer the system takes a few seconds to conduct a POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load the operating system. Once that starts, you can’t get into Setup without rebooting.

The Aptio Setup Utility tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

To enter Setup, turn on the computer and press F2 (give the system a few seconds to enter Setup). If the Boot Logo is enabled the F2 on screen will be highlighted to illustrate that the system is processing the request during the POST (or press F7 for boot options). If you get a “Keyboard Error”, (usually because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7 and choose your preferred boot device.
Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

**Fatal Errors**
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized distributor/supplier as soon as possible.

**Non-Fatal Errors**
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) and you can then press **F7** (the **F7** on screen will be highlighted to illustrate that the system is processing the request) for boot options.

Press **F2** (give the system a few seconds to enter *Setup*; the **F2** on screen will be highlighted to illustrate that the system is processing the request) to run the *Setup* program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
Setup Screens

The following pages contain additional advice on portions of the Setup. Along the top of the screen is a menu bar with menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of the screen.

If these tools are confusing, press F1 to call up a General Help screen, and then use the arrow keys to scroll up or down the page.

The Item Specific Help on the upper right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow ▶ next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may execute a command.
System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., 00 = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.
BIOS Utilities

**SATA Port # (Main Menu)**
Pressing **Enter** opens the sub-menu to show the configuration of a optical Device/HDD on the computer’s SATA Ports.

**System/Extended Memory (Main Menu)**
This item contains information on the system memory, and is not user configurable. The system will auto detect the amount of memory installed.

**MB Series / BIOS Revision / KBC/EC Firmware Revision (Main Menu)**
This item contains information on the BIOS version and video card etc., and is not user configurable.
**Advanced Menu**

*Intel(R) Rapid Start Technology (Advanced Menu)*

Enable/disable **Intel(R) Rapid Start Technology** from this menu. The rapid start hibernation mode can resume power within 5 to 6 seconds and can remember your computer's state with zero power.
Intel Anti-Theft Technology (Advanced Menu)
Anti-Theft Technology, which is built-in to the processor of the computer, allows system administrators to render your computer useless to thieves by sending a poison pill encrypted SMS message over a 3G network etc. Administrators can also remotely unlock a recovered computer quickly, or direct the system to send location information (GPS coordinates) back to a central server.

SATA Mode (Advanced Menu)
You can configure SATA (Serial ATA) control to operate in IDE (native/compatible), AHCI (Advanced Host Controller Interface) or RAID (Redundant Array of Independent disks) modes from this menu. A RAID mode may be set if you have included 2 * mSATA SSDs in your purchase configuration. The SATA Mode should be set BEFORE installing an operating system, and after you have backed up all necessary files and data (see sidebar). See “Setting Up SATA RAID or AHCI Mode” on page 7 - 2 for details.

Make sure you install the Intel Rapid Storage Technology application if you have set the SATA Mode to RAID or AHCI (see “Intel® Rapid Storage Technology” on page 7 - 31).
Boot Logo (Advanced Menu)
Use this menu item to enable/disable the Boot Logo screen at system startup if you have not enabled UEFI Boot. If you disable the Boot Logo you will not see the F2 Enter Setup or F7 Boot Options prompts on the screen, however you can still press these keys, while the boot screen is displayed, to perform the Enter Setup or Boot Option functions.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
**Security Menu**

The changes you make here affect the access to the **Setup** utility itself, and also access to your machine as it boots up after you turn it on. These settings do not affect your machine or network passwords which will be set in your software OS.

**Figure 5 - 4 Security Menu**

**Set Supervisor Password** (Security Menu)
You can set a password for access to the **Aptio Setup Utility**. This will not affect access to the computer OS (only the **Aptio Setup Utility**).
Note: To clear existing passwords press Enter and type the existing password, then press Enter for the new password (without typing any password entry) and Enter again to confirm the password clearance.

Note: You can only set the user password after you have set the supervisor password.

Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may only set a password on boot if a supervisor password is enabled). If “Enabled” is selected, only users who enter a correct password can boot the system (see the warning in the sidebar). The default setting is “Disabled”.

Secure Boot Control (Security Menu)
Secure Boot prevents unauthorized operating systems and software from loading during the startup process. Secure Boot is available as a menu option if you have enabled UEFI Boot (see “Boot Menu” on page 5 - 12). Enabling Secure Boot will bring up the Secure Boot Mode menu to enable you to configure Secure Boot as Standard (with a fixed secure boot policy), or Custom (which enables you to make changes to the Image Execution Policy and Key Management database).

TPM Configuration (Security Menu - Factory Option Only)
This sub-menu will allow you to enable/disable Trusted Platform Module (TPM) support if included in your purchase configuration (see “Trusted Platform Module” on page 7 - 53 for details).
When you turn the computer on it will look for an operating system (e.g. *Windows 7*) from the devices listed in this menu, and **in this priority order**. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the **Boot Option Priorities**. Item specific help on the right is available to help you move devices up and down the order.
Boot Option Priorities (Boot Menu)
Use the arrow keys to move up and down the menu, and press enter to select a device from the menu (the selected device will be highlighted in white).

UEFI Boot (Boot Menu > OS Select)
Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Interface (UEFI) specification provides a clean interface between operating systems and platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard boot and runtime services. The Network Stack item will be enabled as an option under UEFI Boot.
Click **Save Changes and Reset** to save all changes made. Choosing to **Discard Changes**, or **Exit Discarding Changes**, will wipe out any changes you have made to the **Setup**. You can also choose to restore the original **Setup** defaults that will return the **Setup** to its original state, and erase any previous changes you have made in a previous session.
Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

- A small crosshead or Phillips screwdriver
- A small regular slotted (flathead) screwdriver
- An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components.

The chapter includes:

- Removing the Battery
- Removing the Component Bay Cover
- Upgrading the Hard Disk Drive(s)
- Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.
When Not to Upgrade

These procedures involve opening the system’s case, adding and sometimes replacing parts. You should not perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).

Power Safety Warning
Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines).

You must also remove your battery in order to prevent accidentally turning the machine on. Before removing the battery disconnect the AC/DC adapter from the computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning restoring power to the system.

Also note the following when the cover is removed:
- Hazardous moving parts.
- Keep away from moving fan blades.
Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the processor or mainboard.
Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons it is best to remove the battery. **Before removing the battery disconnect the AC/DC adapter from the computer first.**

1. Turn the computer off, remove the AC/DC adapter and turn it over.
2. Slide the latch 1 in the direction of the arrow.
3. Slide the latch 2 in the direction of the arrow and hold it in place.
4. While holding latch 2, slide the battery 3 out of the compartment.

---

**Figure 6 - 1**

**Battery Unlock**
Inserting the Battery
1. Slide the battery 1 straight into the compartment (note that there are grooves on the side of the battery which should align up with the battery compartment).
2. Lock the battery in place by sliding the latches in the direction of arrows 2 & 3.

Figure 6 - 2
Battery Insertion & Lock
Removing the Component Bay Cover

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws 1 - 4.

Figure 6 - 3
Component Bay Cover Screws
3. Lift the cover up at point 4 and remove the cover 5 in the direction of arrow 6.

**Removal Warning**

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning restoring power to the system.

Also note the following when the cover is removed:
- Hazardous moving parts.
- Keep away from moving fan blades.
- Do not touch the heat sink area as the parts may be hot.
Replacing the Component Bay Cover

1. Reinsert the component bay cover by placing it on the bottom case assembly and aligning the three pins 1 - 3 with the slots in the case.
2. Angle the cover up to make sure that the cover pins fit in the slots, and then place the cover down onto the computer and ensure that the fit is tight before replacing the screws 1 - 3 (Figure 6 - 3 on page 6 - 6).
Upgrading the Hard Disk Drive(s)

The hard disk Drive(s) can be taken out to accommodate up to one other 2.5" serial (SATA) hard disk drives with a height of 9.5mm (h) / 7mm (h) (see “Storage” on page D - 3). Follow your operating system’s installation instructions, and install all necessary drivers and utilities (as outlined in “Drivers & Utilities” on page 4 - 1), when setting up a new hard disk.

HDD System Warning

New HDD’s are blank. Before you begin make sure:
You have backed up any data you want to keep from your old HDD.
You have all the CD-ROMs and FDDs required to install your operating system and programs.
If you have access to the internet, download the latest application and hardware driver updates for the operating system you plan to install. Copy these to a removable medium.
Upgrading The Computer

Removing the Hard Disk
1. Turn off the computer, and turn it over and remove the battery and component bay covers (see pages 6 - 4 & 6 - 6).
2. Slide the HDD cover in the direction of arrow 1, and lift it out of the bay 2.
3. Remove screws 3 & 4 and the cover 5.

Figure 6 - 6
Primary HDD Removal

6 - 10 Upgrading the Hard Disk Drive(s)
Reinserting the Hard Disk
1. Reverse the process to install a new disk and do not forget to reinstall the cover and screws (see Figure 6 - 6 on page 6 - 10).
2. Place the hard disk assembly into the bay and slide it in the direction of arrow 1.
3. Replace the component bay cover (see page 6 - 8).

Figure 6 - 7
Inserting the Hard Disk
Upgrading the System Memory (RAM)

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-DIMM) DDR3L type memory modules (see “Memory” on page D - 2). The total memory size is automatically detected by the POST routine once you turn on your computer.
1. Turn off the computer, and turn it over and remove the battery and component bay covers (see pages 6 - 4 & 6 - 6).
2. The memory sockets will be visible at point 1 on the mainboard.
3. Gently pull the two release latches (2 & 3) on the sides of the memory sockets in the direction indicated below.

**Contact Warning**
Be careful not to touch the metal pins on the module’s connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module’s performance.

**Figure 6 - 8**
RAM Module Location

**Figure 6 - 9**
RAM Module Release Latches
4. The RAM module will pop-up, and you can remove it.

5. Pull the latches to release the second module if necessary.

6. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory socket.

7. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the socket as it will go. DO NOT FORCE the module; it should fit without much pressure.

8. Press the module in and down towards the mainboard until the socket levers click into place to secure the module.

9. Replace the component bay cover (see page 6 - 8).
Chapter 7: Modules

Overview

This chapter contains the information on the various modules (some of which are optional) which may come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

• Setting Up SATA RAID or AHCI Mode
• PC Camera Module
• Wireless LAN Module
• Bluetooth & WLAN Combo Module
• Intel® Rapid Storage Technology
• Intel® Rapid Start Technology Driver
• Sound Blaster Cinema EQ
• Trusted Platform Module
• Wireless Display
• 3G Module

You will need to attach an optical device drive to the computer in order to access the drivers on the Device Drivers & Utilities + User's Manual disc.
Setting Up SATA RAID or AHCI Mode

AHCI Mode
Advanced Host Controller Interface (AHCI) is an interface specification that allows the storage driver to enable advanced serial ATA features such as Native Command Queuing (for maximum hard disk efficiency and performance). Make sure you install the Intel® Rapid Storage Technology application if you have set up your hard disk in AHCI mode (see “Intel® Rapid Storage Technology” on page 7 - 31).

RAID
To configure your RAID (Redundant Array of Independent Disks) system in Stripping (RAID 0), Mirroring (RAID 1) or Recovery modes (see Table 7 - 1, on page 7 - 3) you will require at least two identical (see sidebar) mSATA solid state drives (SSDs). Note that you will need to install a driver from the Device Drivers & Utilities + User’s Manual disc at OS installation (see page 7 - 4).

Intel® Rapid Storage Technology Application
Make sure you install the Intel® Rapid Storage Technology application if you have set up your hard disk in AHCI mode or mSATA SSD’s in RAID mode (see “Intel® Rapid Storage Technology” on page 7 - 31).
### RAID Levels

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Identical drives reading and writing data in parallel to <strong>increase performance</strong>. RAID 0 implements a striped disk array and the data is broken into blocks and each block is written to a separate disk drive.</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Identical drives in a mirrored configuration used to <strong>protect data</strong>. Should a drive that is part of a mirrored array fail, the mirrored drive (which contains identical data) will handle all the data. When a new replacement drive is installed, data to the new drive is rebuilt from the mirrored drive to restore fault tolerance.</td>
</tr>
<tr>
<td>Recovery</td>
<td>Two identical drives copying data between a master and a recovery disk. This provides more control over how data is copied between the master and recovery drives, fast volume updates and the ability to view the data in <em>Windows Explorer</em>.</td>
</tr>
</tbody>
</table>

### SATA Mode Selection

The SATA mode selection should be made **before installing your operating system**.  
**DO NOT change your selected SATA mode** unless you intend to reinstall your operating system. Make sure you have backed up all your data before doing so.

### RAID Solid State Drives (SSDs)

All mSATA SSDs in a RAID should be identical (the same size and brand) in order to prevent unexpected system behavior.
SATA RAID Setup Procedure (Windows 8.1)

To configure your RAID (Redundant Array of Independent Disks) system in Striping (RAID 0) or Mirroring (RAID 1) modes (see *Table 7 - 1, on page 7 - 3*) you will require **at least two identical** (see sidebar) mSATA solid state drives (SSDs) installed.

You need to setup a RAID before installing your *Windows 8.1* operating system, and you will need to prepare the following in order to do so.

1. The *Microsoft Windows 8.1 OS DVD*.
2. Two (identical) mSATA solid state drives installed (note that hard disk drive will be used for data storage only in a mSATA SSD RAID configuration).
3. You will need to attach an **external DVD drive** to install the drivers from the *Device Drivers & Utilities + User’s Manual disc*.
5. A USB flash drive.
6. An **operable computer** (to copy files from the *Device Drivers & Utilities + User’s Manual* disc to the USB flash drive).

Before setting up the system you will need to copy a driver folder to a USB flash drive or external USB hard disk. This driver folder is included on the *Device Drivers & Utilities + User’s Manual disc* but you will need to go to an operable computer and copy the folder to a USB Flash drive or external USB hard disk.
1. Go to the operable computer and insert a USB Flash drive or external USB hard disk.
2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive of the operable computer.
3. Copy the f6flpy-x86 or f6flpy-x64 folder from the location below (D: denotes your DVD drive) on the Device Drivers & Utilities + User’s Manual disc to the USB flash drive or external USB hard disk.

   - For Windows 8.1 64-bit = D:\Options\RAID\f6flpy-x64
4. Start-up your notebook computer and press <F2> to enter the BIOS.
5. Go to the Boot menu, select UEFI Setting and press <Enter> (see page 5 - 12).
6. Set UEFI Boot to “Enabled”.
7. Press <Esc> to exit the menu and go to the Advanced menu.
8. Select SATA Mode (see page 5 - 8), press <Enter> and select “RAID Mode”.
9. Press <F4> and <Yes> to “Save Changes and Reset”.
10. After computer restarts press <F2> to enter the BIOS again.
11. Go to Intel(R) Rapid Storage Technology (in the Advanced menu) and press <Enter>.
12. Select Create RAID Volume and press <Enter>.

   ![Create RAID Volume](image.png)

   **Non-RAID Physical Disks:**
13. You can now setup your RAID volume using any installed SSDs.
14. Go to **Name**: and press <Enter>.
15. Type a name of your choice for your RAID volume and press <Enter>.

*Figure 7 - 2*
**Name the RAID Volume (Advanced > Intel(R) Rapid Storage Technology)**
16. Go to **RAID Level**: and press <Enter>.
17. Choose the RAID Level required (see *Table 7 - 1, on page 7 - 3* for details) and press <Enter>.
   - RAID0 (Stripe)
   - RAID1 (Mirror)
   - Recovery
18. Go to any of the disks listed under **Select Disks**: and select a drive name and press <Enter>.
19. Move the cursor down (use the arrow keys) onto to **X** (o select the SSD drives required and press <Enter>.
   - If you have selected a **Recovery** level RAID then you need to select one drive to be **Master disk (M)** and one disk to be the **Recovery disk (R)**. 

![Figure 7 - 3
Select Disks
(Advanced > Intel(R) 
Rapid Storage Technology)](image)
20. You should select two identical mSATA SSDs to form your RAID volume.
21. If you have selected RAID0 (Stripe) then you can adjust the "Strip Size" to your requirements.
22. If you have selected Recovery then you can adjust the Synchronization to "On Request" or "Continuous".
23. Go to Create Volume and press <Enter>.
24. The RAID volume will then be created and the RAID information will be displayed under Intel(R) Rapid Storage Technology (in the Advanced menu).
25. Press <Esc> to exit the menu.
26. Go to the **Boot** menu and make sure your attached DVD drive is set as **Boot Option #1** in **Boot Option Priorities**.

![Boot Option Priorities](Figure 7 - 5)

27. Press <F4> and <Yes> to “Save Changes and Reset”, however **ensure that the two conditions in the bulleted points below are met** before doing so.

- Make sure the **Windows 8.1** OS DVD is in the attached DVD drive, and as the computer starts up it will automatically boot from the **Windows 8.1** OS DVD (you will be prompted to press a key to boot from the DVD).
- Make sure your USB Flash drive or external USB hard disk is attached to one of the USB ports on the computer.

28. Press <F7> as the computer starts up to bring up the boot device menu.
29. Select the DVD drive containing the **Windows 8.1** OS DVD and press <Enter>.
30. Press a key at system startup to begin installing **Windows** from your **Microsoft Windows 8.1** disc.
31. Click **Next > Install Now** to continue installing the operating system as normal (see your **Windows** documentation if you need help on installing the **Windows** OS).
32. A prompt will appear to ask you to **Load Driver**.
33. Click **Browse** and browse to the location you copied the files to on your USB Flash drive or external USB hard disk (X: denotes your USB Flash drive or external USB hard disk):

- **X:\f6flpy-x64 (for Windows 8.1 64-bit)**

34. Click **Next**.

35. Follow the on-screen instructions to install the **Windows 8.1** operating system.

36. Install the **Windows** drivers from the **Device Drivers & Utilities + User’s Manual** disc as per **Table 4 - 1, on page 4 - 3** (make sure you install the Intel Rapid Storage Technology driver - see overleaf).

37. Run the **Intel® Rapid Storage Technology** application to manage your RAID volume as instructed in **“Intel® Rapid Storage Technology for RAID Systems” on page 7 - 32**.

**IRST Driver Installation**

1. Insert the **Device Drivers & Utilities + User’s Manual** disc into an attached DVD drive.
2. Click **Option Drivers** (button).
3. Click **3.Install IRST Driver > Yes**.
4. Click **Next > Next**.
5. Click the tickbox to accept the license and click **Next**.
6. Click **Next > Next > Next**.
7. Click **Finish** to restart the computer.
8. See **“Intel® Rapid Storage Technology for RAID Systems” on page 7 - 32**.
Deleting a RAID (Windows 8.1)

If you wish to delete an existing RAID then follow the procedure below to do so. However, backup any necessary files and data before deleting a RAID, as doing so will result in the loss of all data on the RAID volumes.

1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to Intel(R) Rapid Storage Technology (in the Advanced menu) and press <Enter>.
3. Go to the RAID (listed under RAID Volumes:) and press <Enter>.
4. Select Delete and press <Enter>.
5. Select "Yes" (note that all the data on the volumes will be lost) and press <Enter>.

![Figure 7-6: Delete RAID (Advanced > Intel(R) Rapid Storage Technology)]
PC Camera Module

When the PC Camera application is run the LED indicator to the left of the camera will be illuminated in red (see Figure 1 - 2 on page 1 - 6). Note that you need to use the Camera app in Windows to take pictures and capture video. Use the Fn + F10 key combination (see “Function Keys & Visual Indicators” on page 1 - 10) to toggle power to the PC Camera module.
PC Camera Audio Setup
If you want to capture video & audio with your camera, it is necessary to setup the audio recording options in *Windows*.

1. Go to the **Control Panel**.
2. Click **Sound** (Hardware and Sound) and click **Recording** (tab).
3. Right-click hold and release **Microphone** (VIA High Definition Audio) and make sure the item is not disabled.
4. Double-click **Microphone** (or select **Properties** from the right-click menu).
5. Click **Levels** (tab), and adjust the **Microphone** and **Microphone Boost** sliders to the level required.
6. Click **OK** and close the control panels.
Camera App

1. Run the **Camera** app from the Start screen by clicking on the **Camera** app icon.

2. The camera interface will display two buttons on the right side of the screen.

3. The upper button is used to record video, and the lower button is used to take still pictures.

4. **Right-click** on the screen to bring up menu buttons at the bottom of the screen.

5. These buttons enable you to access the **camera roll** (where captured pictures and video are displayed), set the **timer** (the time period before capture begins; 3 seconds, 10 seconds or Off) and set the exposure level using the slider to obtain the best results.
Camera Options

The Camera Options settings may be accessed as follows:

1. Run the Camera app from the Start screen by clicking on the Camera app icon.
2. While the camera app is running access the Charms Bar (e.g. click Use the Windows logo key + C key combination).
3. Click Settings and then click Options.
4. You can adjust the Photo Aspect Ratio, select the Microphone, Hide/Show grid lines and turn Location Info on or off from the Options panel.

![Figure 7 - 10 Camera Options](image)
Taking Pictures/Capturing Video

1. Run the **Camera** app from the **Start** screen by clicking on the **Camera** app icon.
2. Right-click the screen and select the timer if you require a countdown before capture.
3. Click the appropriate icon to take a picture or start video capture (if video capture begins a timer will appear in the bottom corner of the screen).
4. To stop video capture click the main window again (or click the stop icon).
5. Captured photos and videos will be saved to a **Camera Roll** folder within the **Pictures** folder.

![Camera Roll](image.png)
Camera Roll
1. Run the Camera app from the Start screen by clicking on the Camera app icon.
2. Right-click on the screen to bring up menu buttons at the bottom of the screen.
3. Click Camera Roll.
4. Click the arrows < / > (on either side of the screen) to browse through the captured photos/video, and back to the Camera app.

Editing Photos
1. Clicking on a captured photo will bring up an app bar with a series of buttons.

   ![Edit Buttons](Figure 7 - 12)

   - Camera
   - Delete
   - Open With
   - Set as lock screen
   - Slide show
   - Rotate
   - Crop
   - Edit

2. The Camera button will take you back to the home screen of the camera app.
3. Click Delete to remove any photo from the camera roll (you will be asked to click Delete again to confirm the deletion).
4. The Open With button will allow you to select a program with which to open the photo.
5. You can click Set as Lock screen to set the photo as the lock screen picture.
6. Clicking Slide Show will create a slide show of photos/video in the camera roll.
7. Click Rotate to rotate the picture through 90 degrees.
8. Use the handles to Crop any captured picture, and click Apply to make the changes (you can change the Aspect ratio by clicking the button and selecting an aspect ratio from the menu). You can Save a copy (create another copy of the
photo with the edited changes), **Update original** (which changes the original picture permanently) or **Undo** any changes.

9. Click the **Edit** button to bring up a full suite of tools to edit the photo.

10. Click on the menu headings on the left, and then click on the tool on the right to edit the photo as required.

11. After the editing process is completed right-click on the photo to **Save a copy** (create another copy of the photo with the edited changes), **Update original** (which changes the original picture permanently), **Undo** any changes or **Cancel** the editing.
**Editing Videos**

1. Clicking on a **captured video** will bring up an app bar with a series of buttons.

2. Click **Delete** to remove any video from the camera roll (you will be asked to click **Delete** again to confirm the deletion).

3. The **Open With** button will allow you to select a program with which to run the Video.

4. Clicking **Slide Show** will create a slide show of photos/video in the camera roll.

5. Click **Trim** to edit the video. Use the round buttons at either end of the slider to adjust the video length and click **Save a copy** to save the changes made.

---

**Figure 7 - 14**

*Edit Buttons (for Video Files)*

**Figure 7 - 15**

*Trim Video (for Video Files)*

Click to select and move the rounded buttons to edit the video.
**Video File Size**

Note that capturing high resolution video files requires a substantial amount of disk space for each file. After recording video, check the video file size (right-click the file and select *Properties*) and the remaining free space on your hard disk (go to *My Computer*, right-click the hard disk, and select *Properties*). If necessary you can remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the *Windows 8.1* system requires a minimum of 16GB (32-bit) or 20GB (64-bit) of free space on the *C: drive* system partition. In order to prevent system problems it is recommended that you move any large sized captured video file to a location other than the *C: drive*. 
Wireless LAN Module

If you have included an Intel® or 3rd Party WLAN module in your purchase option make sure that the module is on (i.e. the system is not in Airplane Mode) before installing the driver.

Make sure you install the drivers in the order indicated in *Table 4 - 1, on page 4 - 3*.

*Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.*
3rd Party 802.11b/g/n Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. The operating system is the default setting for Wireless LAN control in Windows (see page 7 - 23).

Intel® WLAN Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click in the tickbox to agree to the End User License Agreement and click Install.
5. Click Finish.
6. The operating system is the default setting for Wireless LAN control in Windows (see page 7 - 23).
WLAN Configuration in Windows

You can configure a wireless connection using one of the following options, however make sure the Wireless LAN module is turned on (and not in Airplane Mode) before configuration begins.

**Charms Bar**
1. Go to the **Charms Bar**.
2. Select **Settings** and then click the **WiFi icon** (it should read **Available** under the icon and **Airplane mode** should be **Off**).
3. A list of available access points will appear.

![Figure 7 - 16 WiFi Settings (Charms Bar) & Networks](image)
4. Double-click an access point to connect to it (or click it and click Connect).
5. Enter a network security key (password) if required, and click Next.
6. You can choose to find other devices or not.
7. When you are connected to the network access point it will display Connected.
8. Select any connected network and click Disconnect to disconnect from a connected access point.
9. You can click the Airplane Mode button to turn the mode (including Bluetooth) On or Off.
10. Alternatively you can click the WiFi button to turn just the WiFi On or Off.

Figure 7 - 17
Networks
Connected / Disconnect

7 - 24 Wireless LAN Module
**Desktop Mode**

1. Switch to the Windows Desktop (click the app or use the Windows logo key + D key combination).
2. Click the wireless icon in the notification area of the taskbar.
3. A list of available access points will appear.
4. Double-click an access point to connect to it (or click it and click **Connect**).
5. Enter a network security key (password) if required, and click **Next**.
6. You can choose to find other devices or not.
7. Select any connected network and click **Disconnect** to disconnect from a connected access point.

![Networks Connections](image)

---

**Figure 7 - 18**
Windows Desktop Taskbar Notification Area WLAN Connection
Bluetooth & WLAN Combo Module

If your purchase option includes the Combination Wireless LAN & Bluetooth module (either Intel® or 3rd Party) then install the driver as instructed overleaf.

Make sure that the module is on (i.e. the system is not in Airplane Mode) before installing the driver.

---

**Bluetooth Data Transfer**

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported). Therefore if you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed.
3rd Party Bluetooth (V4.0) Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.

Intel Bluetooth Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click in the tickbox to accept the license and click Next.
6. Click Finish > Yes.
7. See “Bluetooth Configuration in Windows” on page 7 - 28 for configuration instructions.

High Speed Bluetooth Data Transfer

The Combination Wireless LAN & Bluetooth module supports high speed data transfer. However to achieve such transfer speeds, both devices must support high speed data transfer.

To obtain high speed data transfer make sure that both the WLAN and Bluetooth modules are powered on.

Check your Bluetooth compatible device’s documentation to confirm it supports high speed data transfer.
Bluetooth Configuration in Windows

You can configure a Bluetooth connection as below, however make sure the Bluetooth module is on (or the system is not in Airplane Mode) before configuration.

**Desktop Mode**
1. Switch to the Windows Desktop (click the App or use the Windows logo key + D key combination).
2. Click the notification area of the taskbar and double-click the Bluetooth icon (or click and select **Show Bluetooth Devices**).
3. The **Bluetooth** item in **PC and Devices** will appear.

**OR**

**Charms Bar**
1. Go to the **Charms Bar**.
2. Select **Settings** and then click **Change PC Settings**.
3. Select the **Bluetooth** item in **PC and Devices**.

![Figure 7 - 19 Bluetooth Taskbar Icon & Change PC Settings (Charms Bar -Settings)](image)
4. Make sure that Bluetooth is turned on and a list of discovered devices will appear.

5. Double-click the device you want to pair with the computer and click **Pair**.

6. On first connection the computer will provide you with a pairing code to be entered onto the device.

7. Enter the code into your Bluetooth enabled device and click **Yes** on the computer to complete the pairing.

8. Select a device and click **Remove Device** to disconnect from any device.

---

**Figure 7 - 20**
PC and Devices - Bluetooth

**Figure 7 - 21**
Enter the Passcode
To Make your Computer Discoverable to Bluetooth Devices
1. Switch to the Windows Desktop (click the app or use the Windows logo key + D key combination).
2. Click the notification area of the taskbar, click the Bluetooth icon and click Open Settings.
3. Click Options, and make sure that Allow Bluetooth devices to find this computer check box (Discovery) has a tick inside it.
4. Make sure that the Alert me when a new Bluetooth device wants to connect check box (Connections) has a tick inside it, if you want to be notified when a Bluetooth device wants to connect.
Intel® Rapid Storage Technology

The Intel Rapid Storage Technology application provides high-performance SATA and SATA RAID capabilities. Install the Intel Rapid Storage Technology application (after installing all necessary drivers in the correct order) to support your RAID (if you have two mSATA SSDs installed) system or SATA drive if set up in AHCI mode in the BIOS (see “SATA Mode (Advanced Menu)” on page 5 - 8).

See “Intel® Smart Response Technology” on page 7 - 36 for further information on setting up Smart Response.

IRST Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 3.Install IRST Driver > Yes.
4. Click Next.
5. Click the tickbox to accept the license and click Next.
6. Click Next > Next > Next.
7. Click Finish to restart the computer.

See the following pages for more information if you have set your hard disks up in a RAID configuration.
Intel® Rapid Storage Technology for RAID Systems

Intel® Rapid Storage Technology application displays status information on your RAID configuration. Run the Intel® Rapid Storage Technology application from the item in the Start menu.

When the Intel® Rapid Storage Technology application is launched the system will open the Status window. Here you can view the general health of the storage system. Various volume creation and management options are available depending on the system’s status.
Intel® Rapid Storage Technology Help

If a hard drive member of a RAID volume is reported as “Degraded” or “Failed” it may be possible to recover the volume. If the volume cannot be restored then you will need to recreate the RAID volume and restore the data from a back up. Click the Help menu (or press F1) for instructions on how to recover or recreate RAID Volumes.

Figure 7 - 24
Intel® Rapid Storage Technology Help
RAID Volume Data Verification and Repair

The RAID volume data verification process identifies any inconsistencies or bad data on a RAID 0 or RAID 1 volume. The table outlines what occurs for each RAID level:

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Verify</th>
<th>Verify &amp; Repair</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Bad blocks are identified.</td>
<td>N/A</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Bad blocks are identified. Data on the mirrored drive is compared to data on the source drive.</td>
<td>Bad blocks are reassigned. If the data on the mirrored drive does not match the data on the source drive, the data on the mirrored drive is overwritten by the data on the source.</td>
</tr>
</tbody>
</table>

Replacing and Reverting Recovery and Master Volumes

If a master or recovery drive fails you will need to add a new identical drive and rebuild the recovery volume to the drive. You can also revert the master drive to the state of the previous volume update. For details on how to do this see the help file “Intel® Rapid Storage Technology Help” on page 7 - 33.

See over for details on how to verify and repair RAID volume data. Verification will identify and repair data inconsistencies on the volume.
Verifying and Repairing RAID Volume Data

1. Run the Intel® Rapid Storage Technology application.
2. Click to select the RAID in the pane on the right side of the window.
3. Click Manage and click Advanced.
4. Click Verify, then click Verify (button) to begin the process.
5. The completion percentage will be listed under Status (Verifying)
6. Click Close to complete the process.
Intel® Smart Response Technology

Intel® Smart Response Technology is an Intel® Rapid Storage Technology (RST) caching feature that accelerates computer system performance by using the SSD as cache memory between the hard disk drive and system memory.

System Requirements to support Intel® Smart Response Technology:
- System BIOS with SATA mode set to RAID (see “SATA Mode (Advanced Menu)” on page 5 - 8).
- Intel Rapid Storage Technology software installed.
- A Solid State Drive (SSD) with a minimum capacity of 18.6GB (or with a partition on the drive formatted to more than 18.6GB e.g a 20GB partition set on the SSD). Note that the SSD requires at least 5MB of free unpartitioned and unallocated space (if you have used all the disk space for the partition you will need to shrink some of space for the cache memory’s use).

See overleaf for instructions on enabling Intel® Smart Response Technology.
Enabling Intel Smart Response Technology

1. Run the Intel® Rapid Storage Technology application.
2. Click Enable acceleration under Performance > Smart Response Technology (note that you will at least 5MB of free unpartitioned and unallocated space on the SSD otherwise the Smart Response Technology item will not appear).
3. Select the SSD to be used as a cache device.
4. Select the size from the SSD to be allocated for the cache memory (any remaining space on the SSD can be used for data storage using the simple data single-disk RAID 0 volume that is automatically created).
5. Select the HDD (or RAID volume) to be accelerated (it is highly recommended that you accelerate the system volume or system disk for maximum performance).
6. Select the acceleration mode, and then click **OK** (Enhanced mode is selected by default).

**Note:** Enhanced mode (default): Acceleration optimized for data protection. Maximized mode: Acceleration optimized for input/output performance.
7. The page will refresh and report the new configuration in under **Performance > Smart Response Technology**.

![Figure 7 - 29 Intel® Rapid Storage Technology - Performance (Smart Response Technology)](image-url)
Intel® Rapid Start Technology Driver

Intel(R) Rapid Start Technology can resume power from Hibernation within 5 to 6 seconds and can remember your computer's previous state with zero power.

System Requirements to support Intel® Rapid Start Technology:
- Rapid Start Technology should be enabled in the BIOS (see “Intel(R) Rapid Start Technology (Advanced Menu)” on page 5 - 7).
- Intel Rapid Storage Technology software installed.
- A Solid State Drive (SSD) with a minimum capacity of 18.6GB.
- The Solid State Drive (not the HDD) must be configured as outlined on the following pages to support Rapid Start Technology.
- The Windows operating system must be installed on the system hard disk drive, and not on the Solid State Drive (SSD).

⚠️ Operating System Installation

Note that in order for Intel(R) Rapid Start Technology to function properly the Windows operating system must be installed on the system hard disk drive (e.g. the “C:” drive), and the SSD should be configured as outlined on the following pages. Rapid Start will not function if the operating system is installed on the SSD.

See overleaf for instructions on enabling Intel® Rapid Start Technology.
Intel® Rapid Start Technology Configuration

1. Enable/disable Intel(R) Rapid Start Technology from the BIOS (see “Intel(R) Rapid Start Technology (Advanced Menu)” on page 5 - 7).
2. Go the Windows control panel and double-click Administrative Tools (System and Security) > Computer Management > Storage > Disk Management
3. Right-click the SSD and select Shrink Volume from the menu.

![Figure 7 - 30: Computer Management (Shrink SSD Volume)](Image)
4. Enter the figure, which should be equal to amount of system memory (RAM) in your computer, in “Enter the amount of space to shrink in MB”.

Figure 7 - 31
Shrink Volume
Size

5. Click Shrink (any unallocated file space may be formatted for storage use).

Memory Size (Amount of Space to Shrink)

The figure entered in the “Enter the amount of space to shrink in MB” field above should be equal to the amount of system memory in your computer. In the example above the system memory is 4GB (1024MB * 4 = 4096GB). If you are unsure of your total system memory (RAM) then go to System control panel (System and Security) and check Installed memory (RAM). The memory size will be displayed in GB so convert by multiplying the GB figure by 1024 to get the total in MB (e.g. 8GB = 8192MB).
6. Run the Desktop app and right-click the lower left hot corner (or use the Windows Logo Key + X key combination) and select Command Prompt (Admin).

7. Type “DISKPART”.

8. At the DISKPART command type “list disk”.

Figure 7 - 32
Search for CMD Prompt

Figure 7 - 33
Diskpart - List Disk
9. Type "**select disk #**" (# is disk number where you want to create the store partition, so refer to the results obtained from "list disk" for exact disk number).

10. The message "**Disk # is now the selected disk.**" will appear.

11. Type "**create partition primary**".

12. A "**DiskPart succeeded in creating the specified partition.**" message should appear.
13. Type “detail disk”.

![Image of detail disk command in Diskpart]

14. Type “select Volume #” (# is volume of your storage partition so refer to results obtained from "detail disk" for the exact volume number).

15. The message “Volume # is now the selected volume.” will appear.

![Image of select volume command in Diskpart]
16. Type the following, depending on the format of the SSD.

- For **MBR** formatted SSDs: “set id=84 override” (the id must be set to 84).
- For **GPT** formatted SSDs: “set id=D3BFE2DE-3DAF-11DF-BA40-E3A556D89593”.

17. The message “DiskPart successfully set the partition ID.” will appear.
18. Close the CMD window.
19. Go the **Windows** control panel and double-click **Administrative Tools (System and Security)** > **Computer Management** > **Storage** > **Disk Management**.
20. The disk partition should read **Healthy Hibernation Partition**.

21. **Restart the computer.**
22. **Install the driver (see below).**

**Intel® Rapid Start Technology Driver Installation**

1. Insert the **Device Drivers & Utilities + User’s Manual** disc into the CD/DVD drive.
2. Click **Option Drivers** (button).
3. Click 4. **Install Rapid Start Driver** > **Yes**.
4. Click **Next** > **Next** > **Yes** > **Next** > **Next**.
5. Click **Finish** to restart the computer.
Sound Blaster Cinema EQ

Install the Sound Blaster Cinema EQ to allow you to configure the audio settings to your requirements for the best performance in games, music and movies.

**Sound Blaster Cinema EQ Installation**

1. Insert the *Device Drivers & Utilities + User’s Manual* disc into an attached DVD drive.
2. Click **Option Drivers** (button).
3. Click **5.Install SB Cinema EQ > Yes**.
4. Choose the setup language and click **Next**.
5. Click **Yes** to accept the license.
6. Click **Next > Full Installation** (button).
7. Click **Next > Finish** to restart the computer.

---

Creative Software AutoUpdate

Run the application from the shortcut in the Apps screen and make sure you are connected to the internet, then click Next and follow the on screen instructions to update the software.
Sound Blaster Cinema Application

Run the Sound Blaster Cinema control panel from the notification area of the task-bar (or from the item in the Apps menu). Click on the tabs to access the any of the control panel menus.

Note that the Sound Blaster Cinema audio effects do not apply to audio generated through an HDMI connection.

Figure 7-40
Sound Blaster Cinema (Taskbar Notification Area Icon & Menu)
Sound Blaster Cinema Settings

Sound Blaster Cinema selects the **built-in speakers** by default and this setting may cause some sound quality issues when using headphones. To **adjust the settings for headphones** do the following:

1. Run the **Sound Blaster Cinema** application.
2. Select **Settings** from the menu.
3. Select **Headphones** from the drop-down menu (you can adjust the slider for crossover frequency).
4. Click **OK** and close the application.

*Figure 7 - 41: Sound Blaster Cinema Select Headphones*
Sound Blaster Cinema Controls

Each control has an **On/Off button** to allow you to enable/disable the control, and most controls feature a slider to adjust the levels.

- **Surround**: Provides virtual sound channels to control the level of immersion.
- **Crystalizer**: Enhances audio to make it sound livelier.
- **Bass**: Enhances the bass level of the sound system.
- **Smart Volume**: Minimizes sudden volume changes to avoid the need for constant adjustment.
- **Dialog Plus**: Enhances dialogue levels for movies etc.

**Settings**

You can use the drop down menu to use pre-sets for **Music**, **Movie** or **Games**. Alternatively you can use a **Custom** setting.

*Figure 7 - 42
Sound Blaster Cinema Controls*
Sound Blaster Cinema & HDMI
1. When you connect an HDMI display to the HDMI-Out port, the Sound Blaster Cinema controls will be disabled.
2. A warning box will pop-up and will prompt “...Do you want to select another audio device now?”. 
3. Click No to continue using the HDMI audio output from your external display (do not attempt to select another audio device when connected to the external HDMI display).

Figure 7 - 43
Sound Blaster Cinema HDMI Display Warning
Trusted Platform Module

(Factory Option Only)

The TPM security chip allows you to create and manage digital certificates for user and platform authentication. This type of security is usually administered within large enterprises and organizations, and therefore requires implementation by a system administrator before users can access security features.

Individual users can use the TPM as an authentication with the fingerprint reader.

Make sure you have administrator’s rights to your computer, and have a Windows password enabled for full security protection. In addition Make sure you prepare a removable media (e.g. a USB flash drive) to store passwords etc. before beginning the TPM initialization process.

Before setting up the TPM functions you must initialize the security platform.
Enabling & Activating TPM

1. Restart the computer.
2. Enter the Aptio Setup Utility pressing F2 during the POST/startup.
3. Use the arrow keys to select the Security menu.
4. Select TPM Configuration and press Enter to access the sub-menu.
5. Press Enter to access the TPM Support menu and select Enable to display the full TPM configuration menu.
6. Select TPM State, press Enter and select Enabled to change the TPM state to enabled. You will then need to press F4 to save the changes and restart the computer.

As the computer restarts press F2 to enter the BIOS again and go to the TPM Configuration menu.
8. Select **Pending operation**, press Enter and select the option you require (if you are initializing TPM you should select **Enable Take Ownership** and press Enter). You will then need to press **F4** to save the changes and restart the computer.

9. You can now install the TPM driver (see “Trusted Platform Module (TPM) Driver Installation” on page 7 - 56) and then initialize the TPM.
Trusted Platform Module (TPM) Driver Installation

1. Make sure you have enabled and activated the TPM in the BIOS before installing the driver.
2. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
3. Click Option Drivers (button).
5. Click Next.
6. Click the button to accept the license and click Next.
7. Click Next > Next > Install.
8. Click Finish > Yes to restart the computer.
Initializing TPM

1. Switch to the Desktop app and click the TPM icon right-click the icon in the notification area of the taskbar, and select Security Platform Initialization (or click the Security Platform State taskbar bubble).

2. Click User Settings (tab) and click Yes, or right-click the icon in the notification area of the taskbar, and select Security Platform Initialization (or click the Security Platform State taskbar bubble).

3. The Quick Initialization method will automatically be selected for you (if you need to use advanced settings provided by your network administrator then select Advanced Initialization).

4. You will need to use a removable media (e.g. a USB Flash Drive) to store passwords and data (keep the media in a safe place until required).

5. Select the drive you want to use from the drop-down menu and click Next.
6. Choose the **Security Platform Features** you want to use by clicking the appropriate tickbox.
7. Enter a **Basic User Password** (and re-type to confirm it) and click **Next**.

![Security Platform Settings Tool](image)

8. Click **Next** to confirm the settings.
9. The computer will then initialize the settings.
10. Click **Finish**.
11. Click the tabs and control panels to adjust the settings.
12. Double-click the icon in the taskbar notification area to access the **Infineon Security Platform Settings Tool**, or right-click the icon and select a menu item.

**Figure 7-47**

**Settings**

---

**7 - 58 Trusted Platform Module**
Infineon Security Platform Settings Tool
The Infineon Security Platform Settings Tool allows you to manage and check the TPM state, manage your password information, and to backup and restore the TPM data. As TPM is usually administered within large enterprises and organizations, your system administrator will need to assist you in managing the information here.

Menus
Note that not all the menus pictured here will be available for access. The menu items that appear will be dependent on your configuration settings etc. (see the Help file for full details).

Figure 7 - 48
Infineon Security Platform Settings Tool
Modules

User Settings
This page allows the settings to be configured for the currently logged in Infineon Security Platform user including the ability to change the password, configure secure e-mail, file and folder encryption and Enhanced Authentication. You can also import or delete certificates protected by the security platform.

Figure 7 - 49
Infineon Security Platform Settings Tool (User Settings)
Backup
Here you can configure backup and restore operations. Backup files contain the computer identification and user identification information which is used to match the machine name and user name with the current machine and user during restoration.

Figure 7 - 50
Infineon Security Platform Settings Tool (Backup)
**Modules**

**Migration**

The Migration tab is used to help securely transfer keys and certificates from one platform to another.

*Figure 7 - 51 Infineon Security Platform Settings Tool (Migration)*
Password Reset
Use Password Reset to reset basic user passwords when required.

Figure 7 - 52
Infineon Security Platform Settings Tool (Password Reset)
BitLocker
BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt data on the disk and is done via the Microsoft BitLocker Control Panel Applet. Click Configure and select a drive to be encrypted and then follow the Wizard to begin the encryption process.

Figure 7 - 53
Infineon Security Platform Settings Tool (BitLocker)
Access the Microsoft **BitLocker Drive Encryption** control panel applet from the *Windows* control panel (*System and Security*).

![BitLocker Drive Encryption](image)

*Figure 7-54*  
*BitLocker Drive Encryption*
Advanced
Configure all the Security Platform owner and policy settings from the Advanced tab. The settings that can be changed are for the local computer only.

Figure 7 - 55
Infineon Security Platform Settings Tool (Advanced)
Wireless Display

Wireless Display uses your Wireless LAN module/WLAN Bluetooth Combo module (you need to make sure that your video adapter/display device is compatible with your particular WLAN/Combo module) in conjunction with a compatible video adapter/display device (purchased separately) to allow you to display the contents of the notebook display on another display (e.g. HDTV), without the need to have cables stretching across a room.

You can use the wireless display to play games, browse the internet, display videos or photo slide shows on your TV/external display without using HDMI or A/V cables.

Before configuring Wireless Display you will need to set up your compatible adapter with your display/speakers. Connect the adapter using an HDMI or A/V cable and turn on the display (or in the case of speakers connect them to the wireless speaker adapter with the cables provided with the adapter), and then set the display to the appropriate input channel (see the documentation supplied with your compatible adapter/display for full details).

Note that no driver or application is required for wireless display in Windows 8.1.
Wireless Display Configuration
1. Note that no driver or application is required for wireless display in Windows 8.1.
2. Go to the Charms Bar, select Devices.
3. Click Project.
4. Click Add a wireless display.
5. The system will then search for compatible display devices (this may take up to 
60 seconds so allow time for this to complete).

6. Double-click any detected display device in the list.
7. You may then need to input a pin number for the device to which you are 
   connecting.
8. Click Next.
9. The display will then connect (for specific settings for your display see the documentation supplied with your compatible adapter/display for full details).
10. To disconnect from the display you can select it in **PC and Devices > Devices** and click **Remove Device > Yes**; or go to the **Project** menu (Charms Bar > Devices) and click **Disconnect**.
3G Module

If you have included an optional UMTS/HSPDA+ based 3G Module (Universal Mobile Telecommunications System or High Speed Packet Access) module (see “Communication” on page D - 3 for specification details) in your purchase option, you do not require a driver/application installation for Windows 8.1. Follow the instructions overleaf to install the USIM card (which will be provided by your service provider), and then use the Charms Bar Wireless icon to access the 3G network in the same manner as the WLAN (see page 7 - 73).

Important Notice

If your purchase option includes both Wireless LAN and 3G modules, then the appropriate antennas will be installed. Note that in order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in conjunction with any other antenna or transmitter.

Important Notice - 3G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G module and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and cause interference. When the 3G module is powered on, make sure that the Bluetooth/Wireless LAN modules are powered off.
3G Module USIM Card Installation

Follow the instructions below to install the USIM card (which will be provided by your service provider).

1. Turn **off** the computer, and turn it over.
2. Remove the battery (see “Removing the Battery” on page 6 - 4).
3. Insert the USIM card (at the rear of the battery compartment) as illustrated below until it clicks fully into position, and replace the battery.

**Power Safety Warning**

Before you undertake any installation procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

**USIM Card Orientation**

Note that the USIM card’s readable side (with the gold-colored contacts) should face upwards as illustrated.

*Figure 7 - 60*  
USIM Card Insertion
3G Configuration in Windows
You can configure a 3G connection as below, however make sure the system is not in Airplane Mode before configuration begins.

Charms Bar
1. Go to the Charms Bar.
2. Select Settings and then click the WiFi icon (it should read Available under the icon and Airplane mode should be Off).
3. A list of available access points will appear under Mobile Broadband.
4. Any 3G service provider (connection information is usually stored on the USIM card) will appear under Mobile Broadband.
5. Double-click any connection icon under Mobile Broadband (or click and then click Connect).

6. The system will connect to your network.
7. A Connected will appear alongside the 3G connection (click the connection to view the timer which indicates your connected time for the current session).
8. You can then access the internet, download e-mail etc. as per any internet connection.
9. To disconnect you can select the connection and click Disconnect.
10. You need to either use Airplane Mode, or to turn the Mobile Broadband module off aboard aircraft.

Figure 7 - 63
Mobile Broadband (Disconnect)
EM820W 3G Module PIN Code & Power-Saving

Note that there may be some issues when a PIN Code is set for the EM820W 3G module (if you are unsure of your module version contact your distributor/supplier) in Windows, if Mobile Broadband has been turned off, and the system has resumed from a power-saving state. To prevent any issues it is recommended that you simply do not enable a PIN for the EM820W 3G module. The following provides instructions for disabling the PIN code; for specific instructions on resolving the issue where “Insert a SIM” appears in the connection see “Resolving the “Insert a SIM” issue with the 3G Module (Windows 8.1)” on page 8 - 17.

Disabling a PIN code for a 3G Module
1. Go to the Charms Bar.
2. Click Change PC Settings.

Figure 7 - 64
Change PC Settings
3. Click **Network**.
4. Click the broadband connection under **Mobile Broadband**.
5. Scroll down to **Security** and click **Remove PIN**.
6. Enter the current PIN number and click **OK**.
7. **It is recommended that you do not Enable a PIN for the EM820W 3G module.**
Modules
Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

- **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is actually working. Check the LED Power Indicators (see “LED Indicators” on page 1 - 7) to see the computer’s power status.

- **Connections** - Check all the cables to make sure that there are no loose connections anywhere.

- **Power Savings** - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys configured in your Power Options (see “Configuring the Power Buttons” on page 3 - 9), the **Fn + F4** key combination, or power button to wake-up the system.

- **Brightness** - Check the brightness of the screen by pressing the **Fn + F8** and **F9** keys to adjust the brightness (see Table 1 - 4, on page 1 - 10).

- **Display Choice** - Press **Fn + F7** to make sure the system is not set to “external only” display.

- **Boot Drive** - Make sure there are no optical media and/or USB storage devices in any connected drive.
Backup and General Maintenance

- Always **backup** your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the **serial numbers** if you are storing them out of their original cases, e.g. in a CD wallet.

- Run **maintenance programs** on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

- Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a **Boot** password for the SCU (see “Security Menu” on page 5 - 10).

- Keep copies of vital **settings files** such as network, dialup settings, mail settings etc. (even if just brief notes).

---

**Warranty**

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
Viruses

- Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable directly from the internet.

- Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-mail attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files from people you know as the virus may have infected an address book and been automatically forwarded without the person’s knowledge.

- Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at least instructions on how to make one).
Upgrading and Adding New Hardware/Software

• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).

• Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.
Troubleshooting

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; **Example** - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
### Troubleshooting

#### Problems and Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned on the <strong>power</strong> but it doesn’t work.</td>
<td><em>Battery missing / incorrectly installed.</em> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The battery LED <strong>power</strong> indicator is blinking orange.</td>
<td><strong>Low Battery.</strong> Plug in the DC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are losing <strong>battery power</strong> too quickly.</td>
<td><strong>The system is using too much power.</strong> If your OS has a <strong>Power Options</strong> scheme (see “<strong>Power Plans</strong>” on page 3 - 5) check its settings. You may also be using a peripheral device/USB device that is drawing a lot of power.</td>
</tr>
</tbody>
</table>
| Actual **battery operating time** is shorter than expected.             | **The battery has not been fully discharged before being recharged.** Make sure the battery is fully discharged and recharge it completely before reusing (see “**Battery Information**” on page 3 - 14).
**Power Options have been disabled.** Go to the **Control Panel** in Windows and re-enable the options.  
A peripheral device/USB device is consuming a lot of power. Turn off/remove the unused device to save power. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The computer feels <strong>too hot</strong>.</td>
<td>Make sure the computer is properly ventilated and the Vent/Fan intakes are not blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 14). Make sure you’re using the correct adapter. Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vent/Fan intakes to be blocked.</td>
</tr>
</tbody>
</table>
| **Nothing appears** on screen. | *The system is in a power saving mode.* Toggle the sleep/resume key combination, **Fn + F4** (see “Configuring the Power Buttons” on page 3 - 9).  

*The screen controls need to be adjusted.* Toggle the screen control key combinations **Fn + F8/F9**. If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also check the monitor’s own brightness and contrast controls.  

*The computer is set for a different display.* Toggle the screen display key combination, **Fn + F7**. If an external monitor is connected, turn it on.  

*The screen saver is activated.* Press any key or touch the **TouchPad**. |
| No image appears on the external monitor I have plugged in and powered on. | You haven’t installed the video driver and configured it appropriately from the Control Panel. See Appendix C for instructions on installing and configuring the video driver. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>You forget the boot password.</strong></td>
<td>If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for help.</td>
</tr>
<tr>
<td><strong>The sound cannot be heard or the volume is very low.</strong></td>
<td>The volume might be set too low. Check the volume control in the Volume Control Panel in the Windows notification area, or use the key combination Fn + F5 and F6 (see “Function Keys &amp; Visual Indicators” on page 1 - 10) to adjust.</td>
</tr>
<tr>
<td><strong>Unwelcome numbers appear when typing.</strong></td>
<td>Num Lock is turned ON (see “LED Indicators” on page 1 - 7).</td>
</tr>
</tbody>
</table>

### Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

### Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot keys unique to the regular keyboard may not work.
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>system freezes</strong> or the screen goes dark.</td>
<td><em>The system’s power saving features have timed-out.</em> Use the AC/DC adapter, press the sleep (Fn + F4) key combination, or press the power button if no LEDs are lit.</td>
</tr>
<tr>
<td>The system never goes into a <strong>power saving mode</strong>.</td>
<td>Power Options features are not enabled. Go to the Windows Power Options menu and enable the features you prefer (see “Power-Saving States” on page 3 - 7). Make sure you have enabled Hibernate mode.</td>
</tr>
<tr>
<td>The <strong>Wireless LAN/Bluetooth</strong> modules cannot be detected.</td>
<td><em>The modules are off as the computer is in Airplane Mode.</em> Check the LED indicator to see if it is in Airplane Mode (see “LED Indicators” on page 1 - 7). Use the Fn + F11 key combination to toggle Airplane Mode on/off (see Table 1 - 4, on page 1 - 10).</td>
</tr>
<tr>
<td>The <strong>PC Camera</strong> module cannot be detected.</td>
<td><em>The module is off.</em> Press the FN + F10 key combination in order to enable the module (see “Function Keys &amp; Visual Indicators” on page 1 - 10). Run the camera application to view the camera picture.</td>
</tr>
<tr>
<td>The <strong>Wireless LAN/Bluetooth</strong> modules cannot be configured.</td>
<td>The driver(s) for the module(s) have not been installed. Make sure you have installed the driver for the appropriate module (see the instructions for the appropriate module in “Wireless LAN Module” on page 7 - 21 and/or “Bluetooth &amp; WLAN Combo Module” on page 7 - 26).</td>
</tr>
<tr>
<td>A file cannot be copied to/from a connected <strong>Bluetooth</strong> device.</td>
<td><em>The transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported).</em> If you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process has been completed.</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
</table>
| I cannot obtain high speed Bluetooth data transfer.                    | To obtain high speed Bluetooth data transfer take into account the following:  
  • To achieve high speed transfer speeds, **both devices must support high speed data transfer** (i.e both the computer and the Bluetooth compatible device you are connecting to).  
  • Check your Bluetooth compatible device’s documentation to confirm it supports high speed data transfer, and for configuration information.                                                                                 |
| The computer is off (or in Sleep Mode) but powered by the AC/DC adapter plugged in to a working outlet, or by battery with a capacity above 20%. I have plugged a device into the powered USB port in order to charge it, but the device is not charging. | **The port is not powered on.** Toggle power to the port using the **Fn + power button** combination.  
  
  *This function may not work with certain external USB compliant devices (check your device’s documentation)*. If this is the case, **power the computer on and connect the external USB device** in order to charge it.  
  
  **Note** that this function is designed to help **charge USB compliant devices**, but is **not designed to allow their operation**.                                                                                                               |
| No sound can be heard through an HDMI connected display.               | You have not configured the **HDMI audio output**. See “HDMI Audio Configuration” on page C - 33.                                                                                                                                                                                                 |
| The **Sound Blaster** audio controls don’t work when the system is connected to an external display through an HDMI cable.      | **Note that Sound Blaster Audio will be disabled when you are connecting to an external display through an HDMI connection.** See “**Sound Blaster Audio & HDMI**” on page C - 35.                                                                                                                                 |

---

Problems and Possible Solutions 8 - 11
Troubleshooting

Problem | Possible Cause - Solution
--- | ---
I have connected a Bluetooth Mouse but it loses the Bluetooth connection and no longer responds after a short period of inactivity. | This is an issue with this mouse model and the Intel Wireless 7260 WLAN and Bluetooth combo module series. To resolve this issue do the following:
1. Go to the Device Manager control panel in Windows.
2. Click the arrow alongside Bluetooth to expand the menu if required.
3. Double-click Intel(R) Wireless Bluetooth(R) 4.0 + HS Adapter.
4. Click the Power Management tab.
5. Make sure that the tickbox alongside “allow the computer to turn off this device to save power” doesn’t have a tick alongside it.
6. Click OK and close the control panel.

Figure 8 - 1 - Device Manager (Bluetooth)
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>I have used <strong>Update Driver</strong> in <strong>Device Manager</strong> (Unknown device &gt; Other Devices) to try and install the <strong>Airplane Mode</strong> driver. <strong>Windows</strong> encountered a problem in attempting to update the driver, and a <strong>yellow exclamation mark</strong> appears in <strong>Device Manager</strong> against the <strong>Unknown device</strong>.</td>
<td>It is very important that the drivers are installed in the order indicated in Chapter 4 (which is the numbered installation order on the <strong>Device Drivers &amp; Utilities + User’s Manual disc</strong>). This issue can occur when drivers are manually installed, and not in the correct order.</td>
</tr>
</tbody>
</table>

If you have attempted to **Update Driver** from the **Device Manager** control panel and have encountered problems, then use the method below to correct this:

**To correct this problem:**

7. Go to the **Programs and Features** (**Programs**) control panel in **Windows**.
8. Select any installed Airplane Mode driver item (e.g. Insyde Airplane Mode HID Mini-Driver), and click **Uninstall/Change** to uninstall the current driver.
9. Restart the computer.
10. Insert the **Device Drivers & Utilities + User’s Manual disc** and click **Install Drivers** (button).
11. Double-click the **Airplane AP** item in the menu.
12. Follow the instructions to install the correct driver (you will need to restart the computer as part of the installation process).
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
</table>
| When using a Bluetooth headset the audio appears to be mono and not stereo. | This is a common issue with Bluetooth headsets. To resolve this issue do the following (you will need to repeat this procedure after every boot up, restart, or when the system resumes from hibernation):

1. Go to the Devices & Printers control panel in Windows.  
2. Double-click the Bluetooth headset.  
3. Click Connect to complete the stereo connection.  

OR

1. Go to the Sound control panel in Windows.  
2. Right-click (in the Playback tab) the Bluetooth Stereo Audio device (the default device is Headset).  
3. Click Connect to complete the stereo connection. |
Troubleshooting

EM820W 3G Module PIN Code & Power-Saving

Note that there may be some issues when a PIN Code is set for the EM820W 3G module (if you are unsure of your module version contact your distributor/supplier) in Windows, if Mobile Broadband has been turned off, and the system has resumed from a power-saving state. To prevent any issues it is recommended that you simply do not enable a PIN for the EM820W 3G module. The following provides instructions for disabling the PIN code.

Disabling a PIN code for a 3G Module

1. Go to the Charms Bar.
2. Click Change PC Settings.

Figure 8 - 2 - Change PC Settings
Troubleshooting

3. Click **Network**.
4. Click the broadband connection under **Mobile Broadband**.
5. Scroll down to **Security** and click **Remove PIN**.
6. Enter the current PIN number and click **OK**.
7. It is recommended that you do not Enable a PIN for the EM820W 3G module.

Figure 8 - 3 - Disable PIN
Troubleshooting

Resolving the “Insert a SIM” issue with the 3G Module (Windows 8.1)

1. If a PIN was set for the EM820W 3G module, you have then switched Mobile broadband off (or put the system in Airplane Mode) in Networks, and the system has just resumed from a power-saving state the following error may occur.

2. On resuming from the power-saving state the standard procedure would be to go to Networks in the Charms Bar and turn on Mobile broadband.

3. Go to the Charms Bar.

4. Select Settings and you will then note that the WiFi icon will read Unavailable.

5. Standard procedure would be to click the connection and enter the PIN number to unlock the connection.

6. In this instance you will note that the Mobile broadband connection will read Insert a SIM.

7. In this case you will need to restart the computer.

8. After system restart you can then connect to the Mobile Broadband as normal.

9. To fully resolve this issue it is recommended that you do not Enable a PIN for the EM820W 3G module.
Troubleshooting
Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the ports & jacks which allow your computer to communicate with external devices, connect to the internet etc.
## Interface (Ports & Jacks)

### Ports and Jacks

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Reader</td>
<td>The card reader allows you to use the following digital storage cards: MMC (MultiMedia Card) / RSMMC SD (Secure Digital) / Mini SD / SDHC / SDXC Push the card into the slot and it will appear as a removable device.</td>
</tr>
<tr>
<td>DC-In Jack</td>
<td>Plug the supplied AC/DC adapter into this jack to power your computer.</td>
</tr>
<tr>
<td>External Monitor Port</td>
<td>This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or simultaneous display on the LCD and external monitor/FPD.</td>
</tr>
<tr>
<td>HDMI-Out Port</td>
<td>The HDMI-Out (High-Definition Multimedia Interface) port is an audio/video connector interface for transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or Flat Panel Display etc. as a display device by means of a HDMI cable. <strong>Note that HDMI carries both audio and video signals</strong> (see “HDMI Audio Configuration” on page C - 33).</td>
</tr>
<tr>
<td>Headphone-Out Jack</td>
<td><strong>Headphones</strong> or <strong>speakers</strong> may be connected through this jack. <strong>Note:</strong> Set your system’s volume to a reduced level before connecting to this jack.</td>
</tr>
<tr>
<td>Microphone-In Jack</td>
<td>Plug an external microphone in to this jack to record on your computer.</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RJ-45 LAN Jack</td>
<td>This port supports LAN (Network) functions. <strong>Note:</strong> Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
</tr>
<tr>
<td>Security Lock Slot</td>
<td>To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.</td>
</tr>
<tr>
<td>USB 2.0/1.1 Ports</td>
<td>These <strong>Universal Serial Bus</strong> 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device). The USB 3.0 ports are denoted by their blue color (and is not operational under DOS); USB 2.0 ports are colored black. USB 3.0 will transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0. <strong>Note:</strong> The <strong>powered USB 3.0 port</strong> (see Figure 1 - 5 on page 1 - 12) may be toggled on / off by means of the <strong>Fn + Power Button</strong> key combination. When the powered USB port is on it will supply power (for charging devices only, not for operating devices) when the system is off but still powered by the AC/DC adapter plugged into a working outlet, or powered by the battery with a capacity level above 20% (this may not work with certain devices - see page 8 - 11). <strong>Note:</strong> This function is designed to help charge <strong>USB compliant devices</strong>, but is <strong>not designed to allow their operation</strong>.</td>
</tr>
</tbody>
</table>
Interface (Ports & Jacks)
Appendix B: Control Center

Overview

The following chapter will give a quick description of the functions of the Control Center. The Control Center gives quick access to frequently used controls, power management features and enables you to quickly turn modules on/off. Click the Control Center icons to toggle the appropriate function, or hold the mouse button down and move the dial control where applicable. Certain functions will automatically be adjusted when a power mode is selected. The Control Center in Windows 8.1 works under the Desktop app and not under the Start screen.

Control Center Access

To run the Control Center press the **Fn + Esc** key combination, or double-click the icon in the notification area of the taskbar.

Close the Control Center by clicking the close icon in the top right of the panel (move the cursor onto the top right corner of the panel to highlight it).

*Figure B - 1 - Control Center*
Control Center

Power Modes
You can set a **Power Mode** by clicking the appropriate icon at the top of the **Control Center**. Each power mode will affect the Power Conservation Mode, Airplane Mode, Power Plan and PC camera power etc.

You can click a **Control Center** icon to set an overall power mode and then click individual icons in the **Control Center** to power on/off the Touchpad and PC camera.

<table>
<thead>
<tr>
<th>Modes</th>
<th>Quiet</th>
<th>Power Saving</th>
<th>Performance</th>
<th>Entertainment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon</td>
<td><img src="image" alt="Quiet Icon" /></td>
<td><img src="image" alt="Power Saving Icon" /></td>
<td><img src="image" alt="Performance Icon" /></td>
<td><img src="image" alt="Entertainment Icon" /></td>
</tr>
<tr>
<td>Power Plan</td>
<td>Power Saver</td>
<td>Power Saver</td>
<td>High Performance</td>
<td>Power Saving</td>
</tr>
<tr>
<td>Power Conservation Mode</td>
<td>Balance</td>
<td>Energy Star</td>
<td>Performance</td>
<td>Balance</td>
</tr>
<tr>
<td>PC Camera</td>
<td>ON</td>
<td>OFF</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>TouchPad</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>Airplane Mode</td>
<td>OFF</td>
<td>ON</td>
<td>OFF</td>
<td>OFF</td>
</tr>
</tbody>
</table>

*Table B - 1- Power Modes*
Control Center Menus
The Control Center contains 3 menu headings (System Program, Device and Gaming) under the Power Modes. Click the menu headings and then click any of the buttons outlined on the following pages.

Figure B - 2 - Control Center Menus
Control Center

Power Status (System Program)
The **Power Status** icon will show whether you are currently powered by the battery, or by the AC/DC adapter plugged in to a working power outlet. The power status bar will show the current battery charge state.

Brightness (System Program)
The **Brightness** icon will show the current screen brightness level. You can use the slider to adjust the screen brightness or the `Fn + F8/F9` key combinations, or use the `Fn+ F2` key combination to turn off the LED backlight (press any key to turn it on again).

Volume (System Program)
The **Volume** icon will show the current volume level. You can use the slider to adjust the Volume or the `Fn + F5/F6` key combinations, or use the `Fn+ F3` key combination to mute the volume.

Power Conservation (System Program)
This system supports **Energy Star** power management features that place computers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period of inactivity (see “Power Conservation Modes” on page 3-12). Click either the **Performance**, **Balanced** or **Energy Star** button.
Sleep Button (System Program)
Click either the Hibernate or Sleep buttons to have the computer enter the selected power-saving mode when the \texttt{Fn + F4} key combination is pressed (see “Power-Saving States” on page 3 - 7).

Display Switch (System Program)
Click the Display Switch button to access the menu (or use the \texttt{Win + P} key combination) and select the appropriate attached display mode.

Time Zone (System Program)
Clicking the Time Zone button will access the Date and Time \textit{Windows} control panel.

Desktop Background (System Program)
Clicking the Desktop Background button will allow you to change the desktop background picture.

TouchPad/PC Camera (Device)
Click either of these buttons to toggle the TouchPad or camera module’s power status. The icon will appear dimmed when it is off. Note that the power status of the camera module is also effected by the Power Mode selected (see \textit{Table B - 1, on page B - 2}).

Backlight Keyboard (Device)
Click the button to adjust the keyboard backlight brightness.
**Control Center**

**Left Windows Key (Gaming)**
Click **Disable** to disable the Windows Key on the left side of the keyboard. This may be useful if you are using the keyboard for gaming and wish to avoid accidentally triggering menus with the Windows Key.

**Fan Speed (Gaming)**
The fan speed will adjust itself automatically to control the heat of the CPU. However you can adjust the setting to maximum if you prefer.

**Headphone (Gaming)**
The headphones may be set for different effects using this menu.

**Caps Lock/Scroll Lock/ Number Lock/Airplane Mode**
Click the button to toggle the appropriate lock mode and Airplane Mode.
Appendix C: Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1 - 26.

Video Driver Installation

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3. Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button).

Video (VGA)
1. Click 2. Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

NVIDIA Video (VGA)
1. Click 3. Install NVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to accept the terms of the license agreement.
3. Click Next.
4. Click Close to complete the installation.

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your distributor/supplier for the latest details on video cards supported (see “Video Adapter Options” on page D - 2).
Microsoft Hybrid Graphics

Most notebook computers come with either a **discrete** or **integrated** graphics solution.

**Discrete** graphics solutions feature a dedicated Graphics Processing Unit (GPU) which are capable of playing games, watching HD video or running GPU-based applications. However computers with discrete graphics solutions tend to be heavy in power consumption, and slightly larger in size in order to incorporate the dedicated discrete GPU.

**Integrated** graphics solutions usually feature memory sharing technology to help save power consumption and allow for longer battery life. However computers with integrated graphics solutions will not usually run games, HD video or GPU-based applications without severe limitations.

**Microsoft Hybrid Graphics** is a seamless technology designed to get best performance from the graphics system while allowing longer battery life, without having to manually change settings. Thus when an application is run that requires extra performance or quality, then the system will run the discrete GPU (dGPU); when the system does not require such enhanced performance it will let the integrated (iGPU) handle it.
How the Technology works
When the system is powered up and is displaying just the desktop, the dGPU will be powered off. In this case the system is running in the same way as a system without a discrete graphics solution. However when an application that requires use of the dGPU is run (e.g., a game or HD Video), the dGPU is powered on and takes over the processing duties. If the program is closed, then the dGPU will be powered back down again until required.

Customization Options
Although Microsoft Hybrid Graphics is completely seamless to the user, NVIDIA also allow customization options within the control panel (see “Optimus™ Customization Options” on page C - 28).

UMA Mode & Performance

UMA Mode is designed for maximum power saving, however this does have an affect on the system’s overall video performance (as it is based on the Power saver power plan).

If you require better video performance then it is recommended that you use Optimus Mode. Alternatively you may switch the UMA Mode power plan to Balanced (however power savings will be reduced in this case).

Note that when the power plan is set to UMA Mode the GPU LED indicators may no longer display the correct status.
Intel® Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically allocates as much (up to 1748MB) system memory (RAM) as needed to the integrated video system (the video driver must be installed). DVMT returns whatever memory is no longer needed to the operating system.
Intel® HD Graphics Control Panel

Advanced video configuration options are provided by the Intel® HD Control Panel. To access the control panel see below and overleaf:


Figure C - 1
Apps Screen
Intel® HD Graphics Control Panel

(see over)
OR
2. Right-click the Desktop and select **Graphics Properties** from the menu.

OR
3. Click **Advanced settings** in the **Screen Resolution** control panel in **Windows**.
4. Click the **Intel(R) HD Graphics Control Panel** tab and click **Graphics Properties** (button).
5. Double-click the **Intel(R) HD Graphics** control panel in the **Windows Control Panel**.

![Intel® HD Graphics Control Panel](image)
You may make changes to any of the graphics properties by clicking the appropriate menu panel and adjusting the settings on the right.

Figure C - 3
Intel® HD Graphics Control Panel
Sub-Menus
Some of the menu panels will also have sub-menus (in the top left corner of the menu alongside the icon ⬇️) to display further configuration options.

Figure C - 4
Intel® HD Graphics Control Panel Sub-Menus
Display
Click either Display Settings or Color to make display adjustments, including configuration for any attached external displays.

Multiple Display
At least one other display must be attached in order to view multiple display selection options.

Figure C - 5
Intel® HD Graphics Control Panel
Display Settings
Click the **Display** menu at the top of the screen to display the sub-menus. The **Multiple Displays** menu allows you to configure the display mode of any attached displays (see “**Attaching Other Displays**” on page C - 20).

Figure C - 6
Intel® HD Graphics Control Panel
Display Settings - Multiple Displays

Multiple Display
At least one other display must be attached in order to view multiple display selection options.
3D
This menu allows you to choose how 3D images are displayed. **Quality** displays the most detail, **Balanced** provides better computer performance with good quality and **Custom** allows you to configure the **Anisotropic Filtering**, **Vertical Sync** and **Anti-Aliasing** features to your preferences. Click **Apply** to save changes.

*Figure C - 7*
Intel® HD Graphics Control Panel 3D
**Video Driver Controls**

**Options**

Options allows you to **Customize Hot Keys** (for opening the application, rotating the display, scaling etc..,) to your preferences. Click **Apply** to save changes.

![Figure C - 8 Intel® HD Graphics Control Panel Options](image)

---

**C - 12 Intel® HD Graphics Control Panel**
Click the **Options** menu at the top of the screen to display the sub-menus. The **Information Center** provides details on **System Information**, the **Built-In Display** and any **attached displays**.

Go to the **Preferences** sub-menu in **Options** to configure the preferences for the Intel® HD Graphics Control Panel. Make sure you turn **Tray Icon On** to display the Intel® HD Graphics Control Panel icon in the notification area of the taskbar (as below).

**Figure C - 9**
Intel® HD Graphics Control Panel
Options - Information Center
Video

The **Video Profiles** menu allows you to brighten or darken movies, or to switch to vivid colors. Click **Basic** or **Advanced** to adjust the video settings based on the **Application Settings** or **Driver Settings**. The **Preview** image will display a sample image using the current settings. You can **Save Profile** and name the Profile to recall the settings at any time. Click **Apply** to save changes.

*Figure C - 10*
Intel® HD Graphics Control Panel Video (Basic - Application Settings)
Click the Video menu at the top of the screen to display the sub-menus. The Image Enhancement menu allows you to adjust the Sharpness, Skin Tone Enhancement, Noise Reduction etc. Click Apply to save changes.

Figure C - 11
Intel® HD Graphics Control Panel Video Image Enhancement Basic
The **Image Scaling** and **Gamut Mapping** menus allow you to adjust these items.

*Figure C - 12*

Intel® HD Graphics Control Panel Video
Image Scaling & Gamut Mapping
Power
Choose a Power Plan for when the computer is **Plugged in** or **On battery**. When turned on, the **Display Power Saving Technology** (which adjusts the backlight intensity) battery settings may be adjusted by means of the slider towards **Maximum Quality** or **Maximum Battery**. Click on **Apply** to save changes.

*Figure C - 13*
Intel® HD Graphics Control Panel Power (Battery Settings)
Video Driver Controls

Support
Click **Support** and select an item from the menus to bring up the help and support topics. You will need to be connected to the Internet to access the key resource links.

![Intel® HD Graphics Control Panel Support](image)

*Figure C - 14*
Intel® HD Graphics Control Panel
Support
Display Devices & Options

Note that you can use external displays connected to the HDMI-Out port and/or external monitor port. See your display device manual to see which formats are supported.

### Display Modes

<table>
<thead>
<tr>
<th>Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Display</td>
<td>One of the connected displays is used as the display device (PC screen only or Second screen only).</td>
</tr>
<tr>
<td>Clone/Duplicate</td>
<td>Both connected displays output the same view and may be configured independently</td>
</tr>
<tr>
<td>Extended / Extend</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
<tr>
<td>Collage</td>
<td>A number of connected displays are combined into a single unified higher resolution for larger screen sizes</td>
</tr>
</tbody>
</table>

*Table C - 1
Display Modes*
Attaching Other Displays

To Clone Displays:
1. Attach your external display to the display port/mini display port/HDMI-Out port, and turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display > Multiple Displays (sub-menu).
3. Click Clone from the Select Multiple Display Mode menu.
4. Click Apply, and OK to confirm the settings change.
5. You can select the displays to be used from the Select Active Displays menu.

Figure C - 15
Display > Multiple Displays (Clone)
To Enable Extended Mode:
1. Attach your external display to the display port/mini display port/HDMI-Out port, and turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display > Multiple Displays (sub-menu).
3. Click Extended from the Select Multiple Display Mode menu.
4. Click Apply, and OK to confirm the settings change.

Click the appropriate monitor icon and drag it to match the physical arrangement you wish to use (e.g. the secondary display may be extended left/right/above/below the primary display).

Click Display Settings to make any adjustments required.

Display Settings Extended Desktop
You can have different Colors, Screen Area and Monitor Refresh Rates for each display device provided your monitor can support them.

You can drag the monitor icons to match the physical layout of your displays. Icons and programs may also be dragged between the displays.

Figure C - 16 Display > Multiple Displays (Extended)
To Enable Collage Mode:
1. Attach your external displays to the external monitor port and HDMI-Out port, and turn them on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display > Multiple Displays (sub-menu).
3. Click Collage from the Select Multiple Display Mode menu.
4. Click Enable Collage and click On.
5. Click Vertical or Horizontal to arrange and displays as required.
6. Click Apply, and OK to confirm the settings change.

Collage Mode
Collage mode is used to combine a number of displays into a single unified higher resolution for larger screen sizes.

Figure C - 17
Display > Multiple Displays (Collage)
Attaching Other Displays - Devices (Charms Bar)

You can configure attached displays from Devices (in the Charms Bar).

1. Attach your external display to the external monitor port/HDMI-Out port, and turn it on.
2. Go to the Charms Bar, select Devices.
3. Click Project (you may need to click Second Screen).
4. Click on any one of the options from the menu to select PC screen only, Duplicate, Extend or Second screen only.

Windows Logo Key + P Key Combination

You can use the + P key combination to quickly bring up the Second Screen menu.

You can also use the Display Switch button in the Control Center to access the menu and select the appropriate attached display mode.

You can also use the Fn + F7 key combination to quickly access the Second Screen menu in Windows.

Figure C - 18
Second Screen (Devices)
Configuring an External Display In Windows

1. Attach your external display to the external monitor port/HDMI-Out port, and turn it on.
2. Go to the Screen resolution control panel (see page 1 - 27) in the Desktop app.
3. Click the Detect button.
4. The computer will then detect any attached displays.

![Screen Resolution](image)

**Figure C - 19**
Screen Resolution
Multiple Displays
5. You can configure the displays from the **Multiple Displays** menu.

- Duplicate these displays - Shows an exact copy of the main display desktop on the other display(s)
- Extend these displays - Treats both connected displays as **separate** devices
- Show desktop only on 1/2 - Only one of your displays is used.

*Figure C - 20
Screen Resolution
Multiple Display Options*
NVIDIA Control Panel

More advanced video configuration options are provided in the NVIDIA Control Panel tab.

1. Go to the Control Panel.
2. Double-click NVIDIA Control Panel (click to view the control panel in either Large icons or Small icons if you are in Category view).

Figure C - 21
NVIDIA GeForce.... Control Panel
The **NVIDIA Control Panel** provides additional video configuration controls and tools which allow quick access to features such as image settings, 3D Settings and video configuration.

**Navigating the Control Panel**

Navigate through the control panels in much the same way as you would a web page. Click on the sub-heading tasks in the left menu (and on the highlighted links) for information. Use the buttons on the top left to go back, forward etc.

**Figure C - 22**

**NVIDIA Control Panel**
Optimus™ Customization Options

One of the most important aspects of Nvidia® Optimus™ technology is that it will switch between the integrated GPU and discrete GPU seamlessly and automatically, and does not require any input from the user. However customization options are offered for users who prefer to set their own parameters for GPU usage.

Context Menu

One of the quickest ways to choose which GPU to use for a particular application is by using the “Run with graphics processor” in the context menu.

1. Go to the NVIDIA Control Panel (see page C - 26).
2. Click Desktop from the top menu and select Add “Run with graphics processor” to Context Menu (it should have a tick alongside it).
3. Close the NVIDIA Control Panel.
4. Find the executable file icon of the application you want to run.
5. Right-click the icon and select Run with graphics processor from the context menu.
6. Select either High-performance NVIDIA processor (dGPU) or Integrated graphics (iGPU) to run the program with the selected GPU.

Note the NVIDIA control panel refers to High-performance NVIDIA processor (which is the discrete GPU) and Integrated graphics (which is the integrated GPU).

Figure C - 24
Context Menu with Run with graphics processor
Global Settings
Global settings allows you to set the preferred graphics processor for overall use. Ideally this would be the iGPU for battery life, but this can be set to the dGPU if preferred.

1. Go to the NVIDIA Control Panel (see page C - 26).
2. Click Manage 3D Settings (3D Settings) and select Global Settings (tab).
3. Select either Integrated graphics (iGPU) or High performance NVIDIA Processor (dGPU) from the drop-down menu.
4. Click the Setting menu items to select any options required.
5. Click Apply to save the settings.

Figure C - 25
Global Settings
Video Driver Controls

Program Settings
Program settings allows you to make specific adjustments for installed applications.

1. Go to the NVIDIA Control Panel (see page C - 26).
2. Click Manage 3D Settings (3D Settings) and select Program Settings (tab).
3. Select a program to customize from the drop-down menu, or click Add to add any program that does not appear in the menu.
4. Select the preferred graphics processor for the program from the drop-down menu.
5. Click the Setting menu items to select any options required.
6. Click Apply to save the settings.

Figure C - 26
Program Settings
Video Driver Controls

Set PhysX® Configuration

NVIDIA® PhysX® is a physics engine that can use the GPU to accelerate game and 3D application performance. You can select the GeForce video card or CPU as a PhysX® processor, or configure the computer to auto-select a PhysX® processor (recommended default setting).

1. Go to NVIDIA Control Panel (see page C - 26).
2. Click Set PhysX configuration.
3. Click to Select a PhysX processor from the menu; Auto-select (recommended) is the default setting.
4. Click Apply to save the settings.

Figure C - 27
Set PhysX® Configuration
HDMI Audio Configuration

HDMI (High-Definition Multimedia Interface) carries both audio and video signals. In some cases it will be necessary to go to the Sound control panel and manually configure the HDMI audio output as per the instructions below.

1. Go to the Control Panel.
2. Click Sound (Hardware and Sound) and click Playback (tab).
3. Depending on your display, the playback device may be selected, however in some cases you may need to select the audio device and click Set Default (button).
4. Double-click the device to access the control panel tabs illustrated overleaf.

Volume Adjustment
The sound volume level can be set using the volume control in the Settings menu in the Charms Bar.

Figure C - 28
Sound - HDMI Device (set Default)
5. Adjust the HDMI settings from the control panel tabs.
6. Click OK to close the **Sound** control panel.

Figure C - 29
HDMI Device Properties

C - 34 HDMI Audio Configuration
HDMI Notes
• Connect a device with HDMI support to the HDMI-Out port BEFORE attempting to play audio/video sources through the device.
• To play audio sources through your external display’s (TV or LCD) speakers you will need to go to the audio configuration control panel on the display and configure the audio input accordingly (see your display device manual).

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “Attaching Other Displays” on page C - 20.
3. Set up your external display (TV or LCD) for HDMI input (see your display device manual).
4. You can now play video/audio sources through your external display.

Sound Blaster Audio & HDMI
1. When you connect an HDMI display to the HDMI-Out port, the Sound Blaster Cinema EQ controls will be disabled.
2. A warning box will pop-up and will prompt “…Do you want to select another audio device now?”. 
3. Click No to continue using the HDMI audio output from your external display (do not attempt to select another audio device when connected to the external HDMI display.

Other Applications
If you are using a third party application to play DVDs etc. from any attached DVD device, you will need to consult the application’s documentation to see the appropriate audio configuration (the application must support digital to analog translation).
Video Driver Controls
Appendix D: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer’s release schedule. Check with your distributor/supplier for details.
## Specifications

| Processors | Intel® Core™ i7-4900MQ (2.8GHz) Mobile Processor 8M L3 Cache, 22nm (22 Nanometer), DDR3L-1600MHz, TDP 47W |
| Intel® Core™ i7-4800MQ (2.7GHz) Mobile Processor 6M L3 Cache, 22nm (22 Nanometer), DDR3L-1600MHz, TDP 47W |
| Intel® Core™ i7-4700MQ (2.4GHz) Mobile Processor 6M L3 Cache, 22nm (22 Nanometer), DDR3L-1600MHz, TDP 47W |
| Intel® Core™ i7-4600M (2.9GHz) Mobile Processor 4M L3 Cache, 22nm (22 Nanometer), DDR3L-1600MHz, TDP 37W |
| Intel® Core™ i5-4330M (2.8GHz) Mobile Processor 3M L3 Cache, 22nm (22 Nanometer), DDR3L-1600MHz, TDP 37W |
| Intel® Core™ i5-4300M (2.6GHz) Mobile Processor 3M L3 Cache, 22nm (22 Nanometer), DDR3L-1600MHz, TDP 37W |

| Memory | Dual Channel DDR3L |
| *Three 204 Pin SO-DIMM Sockets Supporting DDR3L 1600 MHz Memory Modules (real operational frequency depends on the FSB of the processor) |
| Memory Expandable up to 16GB Compatible with 2GB, 4GB or 8GB Modules |

| Display | 13.3" (33.78cm) FHD (1920 * 1080), 16:9, 2.6mm - 2.8mm Thick Backlit Panel |

| Video Adapter Options | Intel® Integrated GPU and NVIDIA® GeForce Video: Supports NVIDIA® Optimus Switchable GPU Technology between iGPU and dGPU |
| Intel® HD Graphics 4600 (GPU Type Depends on Processor) Dynamic Frequency Intel® Dynamic Video Memory Technology Supporting Shared Memory up to 1.7GB Supports Microsoft DirectX® 11 |
| NVIDIA® GeForce GTX 860M PCIe * 8 Video Chip 2GB GDDR5 Video RAM On Board Supports Microsoft DirectX® 11.1 NVIDIA PhysX™ GeForce CUDA™ Technology NVIDIA® Optimus™ Technology |
### Specifications

#### Storage
- One Changeable 2.5", 9.5 mm (h) / 7 mm (h) **SATA** (Serial) Hard Disk
- mSATA SSD (RAID 0/1) with SATA Interface

#### Audio
- High Definition Audio
- Built-In Microphone
- 2 Built-In Speakers
- Sound Blaster™ Cinema
- ANSP™ 3D Sound Technology on Headphone Output

#### Keyboard & Pointing Device
- Isolated Illuminated Keyboard
- Built-In TouchPad (with Multi Gesture and Scrolling Functionality)

#### Interface
- One USB 2.0 Port
- Three USB 3.0 Ports (Including one AC/DC Powered USB 3.0 Port)
- One HDMI™-Out (High-Definition Multimedia Interface) Port (with HDCP)

#### Card Reader
- Embedded Multi-In-1 Push-Push Card Reader
  - MMC / RSMMC
  - SD / Mini SD / SDHC / SDXC

**Note:** Some of these cards require PC adapters that are usually supplied with the cards.

#### Slots
- Three Mini-Card Slots:
  - **Slot 1** for Half Size Mini-Card WLAN Combo Module with PCIe & USB Interfaces:
  - **Slot 2** for Full Size Mini-Card mSATA SSD (Solid State Drive) with SATA Interface

#### Communication
- Built-In 10/100/1000Mb Base-TX Ethernet LAN
- 1.0M HD PC Video Camera Module
- OR
- 2.0M FHD PC Video Camera Module (Factory Option)

**Intel® Dual Band Wireless-N 7260** (2*2 802.11 a/g/n) Half Mini-Card PCIe WLAN + Bluetooth Combo Module (Factory Option)

**Intel® Wireless-N 7260** (2*2 802.11 b/g/n) Half Mini-Card PCIe WLAN + Bluetooth Combo Module (Factory Option)

**Intel® Dual Band Wireless-AC 7260** (2*2 802.11 a/c) Half Mini-Card PCIe WLAN + Bluetooth Combo Module (Factory Option)

(see over)
## Specifications

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Windows® 8.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Features</td>
<td>Painted Style for some designs</td>
</tr>
<tr>
<td></td>
<td>Intel® Rapid Start Technology</td>
</tr>
<tr>
<td></td>
<td>Intel® Smart Response Technology</td>
</tr>
<tr>
<td>Indicators</td>
<td>LED Indicators - Power/Suspend, Battery, HDD, Airplane Mode, Num Lock, Caps Lock, Scroll Lock, Camera</td>
</tr>
<tr>
<td>Power</td>
<td>Full Range AC/DC Adapter – AC in 100 - 240V, 50 - 60Hz DC Output 19.5V, 6.15A (120 Watts)</td>
</tr>
<tr>
<td></td>
<td>Removable 6 Cell Smart Lithium Ion Battery Pack 62.16WH</td>
</tr>
<tr>
<td>Power Management</td>
<td>Supports Wake on LAN</td>
</tr>
<tr>
<td></td>
<td>Supports Wake on USB</td>
</tr>
<tr>
<td></td>
<td>Supports Wake on RTC Alarm (AC Mode Only)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Environmental Spec</th>
<th>Temperature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating:</td>
<td>5°C - 35°C</td>
</tr>
<tr>
<td>Non-Operating:</td>
<td>-20°C - 60°C</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Relative Humidity</th>
<th>Operating: 20% - 80%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-Operating:</td>
<td>10% - 90%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Physical Dimensions &amp; Weight</th>
<th>330mm (w) * 227mm (d) * 31.9mm (h)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2.0kg Barebone System* with 62.16WH Battery</td>
</tr>
</tbody>
</table>

A barebone system does not include the CPU, HDD, RAM, adapter, power cord, VGA card and factory option modules (weight tolerance within +/-5%).